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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP 
Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product 
support service. Contact your HP sales representative for details.
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Support

You can visit the HP Software Support web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and 
support that HP Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and 
efficient way to access interactive technical support tools needed to manage your business. 
As a valued support customer, you can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. 
Many also require a support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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Welcome to the Business Process Testing 
Tutorial

Welcome to the HP Business Process Testing tutorial. 

Business Process Testing with HP Quality Center enables non-technical 
Subject Matter Experts to build and work with business components in a 
script-free environment. A business process test is a scenario comprising a 
sequence of business components or flows of components, designed to test a 
specific business process of an application.

This tutorial is a self-paced guide that teaches you the basics of Business 
Process Testing. You access Business Process Testing from Quality Center. 
The tutorial will familiarize you with the process of creating, implementing, 
and running keyword-driven business components in business process tests 
and flows. 

This tutorial focuses on creating manual component steps, and then using 
them as a basis for creating automated steps in keyword-driven components. 
Manual steps can also be used to run both manual and automated business 
components manually, using the Manual Runner. For more information, see 
the HP Business Process Testing User Guide.

Note: This tutorial does not describe working with WinRunner components. 
For more information on WinRunner components, see the HP Business 
Process Testing User Guide and the HP WinRunner User’s Guide.
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This chapter includes:

 ➤  Before You Begin on page 8

 ➤  Using This Tutorial on page 9

Before You Begin

This tutorial teaches you how to create business process tests using 
keyword-driven components. 

To perform this tutorial, you must have access to:

Quality Center 10.00. The HP Web-based solution for application life cycle 
management. You must have licenses available for Quality Center and 
Business Process Testing, and be able to access these modules: Business 
Components, Test Plan, and Test Lab.

QuickTest Professional 10.00. The testing tool used to run the automated 
business process tests used in this tutorial. You must: 

➤ Have the proper version of QuickTest Professional installed on your 
computer. 

➤ Enable the Allow other HP products to run tests and components option 
in QuickTest (Tools > Options > Run pane). For more information, see the 
HP QuickTest Professional User Guide.

➤ Install the QuickTest Professional Add-in and the Quality Center 
Connectivity Add-in from the Quality Center Add-ins page. For more 
information, see the HP Quality Center Installation Guide.

QualityCenter_Demo. A demonstration project that helps introduce you to 
Quality Center.

➤ The lessons in this tutorial are based on the QualityCenter_Demo 
project. Verify with your administrator that you are working with the 
correct version of the QualityCenter_Demo project. This version is 
available with Quality Center Patch 2 (or above) and is obtained by 
importing the QualityCenter_Demo.qcp file using Site Administration. 
For more information, refer to the HP Quality Center Installation Guide.
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➤ If the Quality Center demo project is not installed on your server, or if 
the project has been modified by other users, contact your 
Quality Center administrator to get a new (clean) copy of the demo 
project installed on your server.

Mercury Flight Reservations. A sample application that simulates an 
application for reserving flights. This application is installed by default with 
QuickTest Professional. If it is not currently installed, you must modify the 
QuickTest installation by selecting the QuickTest Professional > Samples 
option in Custom Setup.

Using This Tutorial

The tutorial is divided into lessons, in which you will create and run 
business components on the sample Mercury Flight Reservations 
application. After completing the tutorial, you can apply the skills you have 
learned to your own application. 

Lesson 1, “Introducing Business Process Testing,” introduces you to 
Business Process Testing, provides an overview of the Business Process 
Testing user interface, and familiarizes you with the sample Mercury Flight 
Reservations application.

Lesson 2, “Creating Business Components,” teaches you how to create 
non-automated components and define component details.

Lesson 3, “Creating Business Process Tests,” teaches you how to build 
business process tests.

Lesson 4, “Automating Components,” teaches you how to convert your 
non-automated components to keyword-driven components and to 
associate each of your business components with an application area.

Lesson 5, “Adding Keyword-Driven Component Steps,” teaches you how to 
add keyword-driven steps to your business components.

Lesson 6, “Debugging Business Process Tests,” teaches you how to run a 
business process test and identify problems.
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Lesson 7, “Working with Parameters,” teaches you how to define input and 
output component parameters, and how to create flows and groups.

Lesson 8, “Running Business Process Tests,” teaches you how to run 
business process tests and view the results.

Lesson 9, “Where Do You Go from Here?,” explains how to start testing your 
own applications and where to find more information on Business Process 
Testing.
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1
Introducing Business Process Testing

This tutorial provides a step-by-step guide introducing you—the Subject 
Matter Expert—to the process of creating and running keyword-driven 
business components, flows, and business process tests, using the Business 
Components, Test Plan, and Test Lab modules in Quality Center.

This tutorial assumes that you are familiar with Quality Center procedures 
or have at least completed the Quality Center tutorial. For more 
information, see the HP Quality Center User Guide and the HP Quality Center 
Tutorial.

Note: When working in a version control enabled project in Quality Center, 
you can create and manage Quality Center entities while maintaining 
previous versions of those entities. When version control is enabled, 
toolbars and menus may contain additional buttons and commands not 
shown is this tutorial. For more information about version control, see the 
HP Quality Center User Guide.

In this lesson, you will learn about:

 ➤  About Business Process Testing on page 12

 ➤  Understanding Business Process Testing Roles and Workflow on page 16

 ➤  Starting Business Process Testing on page 19

 ➤  Exploring the Business Components Module Window on page 21

 ➤  Exploring the Test Plan Module Window on page 24

 ➤  Exploring the Mercury Flight Reservations Application on page 27
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About Business Process Testing

Business Process Testing enables Subject Matter Experts to design quality 
assurance tests early in the development cycle and in a script-free 
environment. 

Business Process Testing is based on the creation, implementation, and 
running of business components and flows in business process tests using 
the Quality Center Business Components, Test Plan, and Test Lab modules. 

➤ The Business Components module enables you to create, manage, and 
automate reusable business components, comprising steps that perform 
specific tasks in a business process. 

➤ The Test Plan module enables you to add components to flows and business 
process tests, add flows to business process tests, and then to debug the 
components.

➤ The Test Lab module enables you to run flows and business process tests in 
test sets and then view detailed results.

As part of the Business Process Testing process, Automation Engineers create 
application areas that contain the resources and settings required for the 
business components of a particular application or part of an application. 
Subject Matter Experts then associate keyword-driven components with 
these application areas to enable the components to access all of the 
required resources and settings. An Automation Engineer can create 
multiple application areas for different purposes, as needed.

A sample application area is provided for the purposes of this tutorial, 
enabling you, the Subject Matter Expert, to focus on learning how to create 
components and business process tests.
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Introducing Business Process Testing Terminology
The following terminology, specific to Business Process Testing, is used in 
this tutorial: 

Application Area. Application areas contain all of the settings and resources 
required to create the content of keyword-driven business components for a 
particular application or part of an application. These include 
representations of the objects from your application contained in the shared 
object repository, user-defined operations contained in function libraries, 
recovery scenarios, and so on. 

Automation Engineer. An expert in an automated testing product, such as 
QuickTest Professional or WinRunner. Using such a testing tool, the 
Automation Engineer creates application areas and the object repository, 
library files, and recovery scenarios associated with these application areas. 
The Automation Engineer can also assist with the debugging process after 
the Subject Matter Expert creates automated business process tests.

Business Component (or Component). An easily-maintained, reusable unit 
comprising one or more steps that perform a specific task. You can use 
business components in multiple tests and flows. A business component can 
be defined as a manual or automated component. Business components 
may require input values from an external source or from other 
components, and they can return output values to other components.

Business Process Test. A scenario comprising a sequence of business 
components or flows, designed to test a specific business process of an 
application.

Business Process Test Status (or Flow Status). A status value that is 
automatically generated based on the status values of all the business 
components in a business process test or flow.

Business Process Test Run-Time Parameters. Variable values that a business 
process test or flow can receive and then pass to business components or 
flows for use as input values.

Component Input Parameters. Variable values that a business component 
can receive and use as the values for specific, parameterized steps in the 
component.
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Component Output Parameters. Values that a business component can 
return. These values can be viewed in the business process test results and 
can also be used as input for a component or flow that is used later in the 
test.

Component Request. A request for the creation of a new business 
component, when no existing component answers the needs of a business 
process test or flow.

Component Status. See Status (Component).

Flow. A reusable collection of business components in a fixed sequence that 
performs a specific task. You can use flows in multiple business process tests. 
Flows may require input values from an external source or from other 
components or flows, and they can return output values to other 
components or flows.

Flow input parameters. Variable values that enable you to define data used 
by a flow that is provided to the flow from an external source. 

Flow output parameters. Values that enable you to define data that is 
retrieved and stored by a flow and can be used in subsequent components in 
a flow.

Implementation requirements. Details and information, written by the 
Subject Matter Expert that creates a business component, describing a 
general overview of the business component’s purpose or goals, and the 
condition of the application before and after a component is run (the 
pre-conditions and post-conditions).

Iterations. The number of times that an individual business component, 
group of components, or flow, runs within a single test run, or the number 
of times that an entire business process test runs within a test set.

Pre-Condition and Post-Condition. The state of the application before the 
first step in a business component, and the state of the application after the 
last step in a business component. For example, the pre-condition for a 
component may state that all applications should be closed, or a specific 
application should be open to a specific screen or with a specific dialog box 
displayed. A post-condition may state that an application should be open to 
a particular screen, or be closed. 



Lesson 1 • Introducing Business Process Testing

15

If you want the business component to allow iterations, the post-conditions 
should specify that the application’s end state must match its state at the 
beginning of the component. The pre-conditions and post-conditions 
provide a guide when implementing the steps for the business component.

Roles. The various types of users who are involved in Business Process 
Testing.

Run condition. A conditional statement you can insert into a flow to check 
the current value of a given parameter before running a component in a 
flow. The run condition determines whether to run the component, skip the 
component run, or skip and set the component status to fail.

Status (Component). A status value that indicates whether a business 
component is fully implemented, debugged, and ready to be run in a 
business process test or flow. The component with the most severe status 
determines the status of the entire test or flow. The status can be modified 
by the Subject Matter Expert in Quality Center and the Automation 
Engineer in QuickTest or WinRunner.

Status (Business Process Test, or Flow). A status value that is automatically 
generated based on the status values of all the business components in the 
business process test or flow.

Steps. Individual operations in a component. These can be manual steps or 
detailed automated testing steps and are designed and implemented in a 
business component to test the workings of a specific task in an application.

Subject Matter Expert. The expert who uses Quality Center to create 
business components, flows, and business process tests. The Subject Matter 
Expert knows the application being developed and tested. The Subject 
Matter Expert creates business components and then combines the business 
components into business process tests and flows, using the resources 
defined by the Automation Engineer to add object and function steps using 
the Keyword View. The Subject Matter Expert can check the components 
within business process tests by running and debugging them and can then 
include them in test set runs to test the application.
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Understanding Business Process Testing Roles and 
Workflow

The Business Process Testing model is role-based, allowing non-technical 
Subject Matter Experts to work on tests with Automation Engineers, both 
together and in parallel. These roles are flexible, and depend on the abilities 
and time resources of the personnel using Business Process Testing. There 
are no limitations or product-specific rules controlling which roles must be 
defined in a particular organization, or which types of users can do which 
Business Process Testing tasks (provided that the users have the correct 
permissions).

The Business Process Testing model also follows a workflow that is 
supported by the user interface design. By following the roles and workflow 
that Business Process Testing offers, you can maximize the quality and 
efficiency of the testing process in your organization.
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The Business Process Testing workflow consists of the following main 
phases:

 1 Create manual business components

Create manual business components in the Business Components module 
by defining details and manual steps.

 2 Create flows of components

Drag and drop your business components into flows in the Test Plan 
module.

 3 Add flows and components to a business process test

Drag and drop your flows and business components into a business process 
test in the Test Plan module. 
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 4 Automate components

Convert each business component to an automated keyword-driven 
component and select an application area to use with each component.

 5 Add keyword-driven steps to your components

Define the automated steps that perform specific tasks in each business 
component.

 6 Debug components

Run your business components in the test to ensure that they perform 
successfully and without interruption. This phase should be repeated after 
each significant enhancement to the test.

 7 Define component parameters

Expand the scope of your business components, flows, and business process 
tests by replacing fixed values with component parameters.

 8 Run test and view results

Run your business process test and view the results to pinpoint defects in 
your application. 

Before you begin creating business components, you should familiarize 
yourself with the module windows used in Business Process Testing, and the 
Mercury Flight Reservations sample application. These topics are described 
in the next sections.
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Starting Business Process Testing

You start working with Business Process Testing by logging in to 
Quality Center and opening the Business Components module. 

To start working with Business Process Testing:

 1 Open the Quality Center Options window.

In your Web browser, enter your Quality Center URL: 
http://<Quality Center server name>[<:port number>]/qcbin. Contact your 
system administrator if you do not have the correct path.

The Quality Center options window opens.

 2 Open Quality Center.

Click the Quality Center link.

The first time you run Quality Center, the application is downloaded to 
your computer. Then, each time you open Quality Center, it automatically 
carries out a version check. If Quality Center detects a newer version, it 
downloads the latest version to your computer. 
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The Quality Center login window opens.

 3 Log in to your Business Process Testing tutorial project.

In the Login Name box, enter the following user name: alex_qc.

Leave the Password box blank. The above user name does not have a 
password assigned to it.

Click the Authenticate button. The Domain and Project boxes are enabled.

In the Domain list, select the DEFAULT domain.

In the Project list, select the QualityCenter_Demo project.

Click the Login button.
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The Welcome to Quality Center window may open. You can access 
Quality Center documentation from this window, or you can select 
Help > Documentation Library from the main Quality Center window. 
Select Don’t show this again and click Close.

The Quality Center main window opens. The domain name, project name 
and user name you entered are displayed in the title bar.

Note: After login, Quality Center displays the module in which you (the 
user name you entered) last worked.

Exploring the Business Components Module Window

Business components are created in the Quality Center Business 
Components module. In this section, you will explore the main elements of 
this module.

 1 Open the Business Components module.

If the Business Components module is not currently displayed in 
Quality Center, click the Business Components module button in the 
sidebar. The Business Components module opens.

The Quality Center demo project includes the folder Completed BPT 
Tutorial, which contains all the components created in this tutorial. It also 
contains the Flight Application folder, which includes additional sample 
components. 

Select any component in the components tree.
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 2 Explore the elements of the Business Components module.

The Business Components module window is shown below, displaying the 
Details tab for a keyword-driven component. 

The Business Components module window contains the following key 
elements used in this tutorial:

➤ Business Components module menu bar. Contains menus with Business 
Components module commands, from which you can perform module 
commands, such as those for creating new components and folders in the 
component tree, copying and pasting, and changing the displayed view.

(The Analysis menu is available with Patch 2 of Quality Center version 
10.00.) 

Quality Center 
common toolbar

Component
tree

 
Module
menu 
bar

Quality Center
sidebar

 
Toolbar

Business Components 
module tabs



Lesson 1 • Introducing Business Process Testing

23

➤ Components toolbar. Contains buttons for frequently-used commands in 
the Business Components module. 

These commands enable you to create and delete folders and business 
components, filter and sort the components displayed in the tree, validate 
components, and send component information to other users by e-mail.

Tip: You can access many of the menu and toolbar commands by 
right-clicking in panes or on items in the component tree to access context 
menus. You can also perform some menu commands using shortcut keys.
For more information, see the HP Business Process Testing User Guide.

➤ Component tree. Enables you to construct and organize the hierarchy of 
your business component folders and individual components. 

➤ Component tabs. Selecting a business component in the component tree 
displays a set of tabs that provide a complete overview of the component’s 
content, detail its input and output component parameters, describe the 
component steps, and list the business process tests or flows in which it is 
used. 

➤ Sidebar. Enables you to select the required Quality Center module.

New
Folder Delete

Set Filter/
Sort

New 
Com ponent

Refresh 
Selected

Validate 
Component

Send by
E-Mail
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Exploring the Test Plan Module Window

Business components are combined into business process tests and flows in 
the Quality Center Test Plan module. In this section, you will explore the 
Business Process Testing elements of the Test Plan module.

 1 Open the Test Plan module.

Click the Test Plan module button in the sidebar. The Test Plan module 
opens.

The Quality Center demo project includes the folder Completed BPT 
Tutorial, which contains all the business process tests created in this tutorial. 
It also contains the Flight Application (BPT Demo) folder, which includes 
more sample business process tests.

Select any test in the test plan tree.

 2 Explore the Business Process Testing elements of the Test Plan module.

The Test Plan module window is shown below, with the Test Script tab of a 
business process test selected. 

Test Plan Tree

Test Pane

Test Plan Tabs

Component
Details Pane

Components and
Flows Pane
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When the Test Plan Tree view is displayed, the Test Plan module window 
contains the following key elements:

➤ Test Plan Menu Bar. Contains the Tests, Edit, View, and Analysis menus, 
from which you can perform Test Plan module commands, such as those for 
creating new business process tests, changing the displayed view, and 
generating reports.

➤ Test Plan Toolbar. Contains buttons for the commands that are commonly 
used when creating and modifying the test plan tree, such as creating or 
deleting business process tests, refreshing the data, and filtering the tree. For 
more information about these commands, see the HP Quality Center User 
Guide.

Tip: You can also access many of the menu and toolbar commands by 
right-clicking in panes or on items in the test plan tree to access context 
menus. You can also execute some menu commands using shortcut keys.
For more information, see the HP Business Process Testing User Guide.
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➤ Test Plan Tree. The Test Plan Tree is a graphical representation of your test 
plan, displaying subject folders, business process tests, and flows according 
to the hierarchical relationship of their purpose within the business process.

Note: You can also view business process tests, flows, and other test types in 
the Test Grid view. In that view, you can see all tests at once, sort and filter 
them according to your needs, and take advantage of other test 
management options. For the purposes of this tutorial, you will be working 
only in the Test Plan Tree view. For more information on the Test Grid view, 
see the HP Quality Center User Guide.

➤ Test Plan Tabs. Selecting a business process test or flow in the test plan tree 
displays a set of tabs that provide a complete overview of the test or flow 
and its status. 

 3 Click the Test Script tab.

➤ Test Pane. For each business component in the business process test or flow, 
the Test pane in the Test Script tab displays the name, status, input and 
output component parameters, and indicates whether the test or flow will 
continue if that component fails during the run.

➤ Components and Flows Pane. The Components and Flows pane can 
optionally be displayed on the right side of the Test Script tab by clicking 
the Select Component button in the toolbar. The Components tab and the 
Flows tab in the Components and Flows pane contain the business 
components and flows that are available to be included in business process 
tests. 

Now that you are familiar with the main Quality Center modules used for 
Business Process Testing, take a few minutes to explore their key elements.

In the next section, you will familiarize yourself with the Mercury Flight 
Reservations sample application.
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Exploring the Mercury Flight Reservations Application

Mercury Flight Reservations is the sample application used throughout this 
tutorial. It simulates a Windows-based flight reservation service. This section 
enables you to familiarize yourself with this application before starting the 
tutorial.

Logging into the Mercury Flight Reservations Application
Before you simulate booking, updating, or deleting a flight in the Mercury 
Flight Reservations application, you must log in as a user.

To log in to Mercury Flight Reservations:

 1 From the Start menu, select Programs > QuickTest Professional > Sample 
Applications > Flight. The Login dialog box opens.

 2 Enter a name with at least four characters in the Agent Name box. The agent 
name mercury is used in this tutorial.

 3 Enter mercury in the Password box. The password is not case-sensitive. 

Note: The characters you enter for the password are displayed as asterisks.

 4 Click OK. While the Mercury Flight Reservations application loads, the 
Mercury Flight Reservations splash screen is displayed. Loading the 
application may take a few seconds.
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 5 The Flight Reservation window opens.

Explore and experiment with the options and menu commands in this 
application, including inserting an order, opening an existing order, and 
updating an existing order. These are the business processes that you will be 
testing while working in this tutorial.

 6 Configure default Settings for order number 3 used in the tutorial.

This tutorial uses the default settings for order number 3 provided in the 
sample Flight Reservations database. Before you proceed with the other 
lessons in this tutorial:

➤ Select File > Open Order in the Flight Reservation window to open the 
Open Order dialog box, select Order No. and enter 3 in the text box.

➤ Click OK to open order number 3 and make sure Economy is selected in 
the Class area of the Flight Reservation dialog box. If Economy is not 
selected, select it and click Update Order.
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When you have finished exploring the application, select File > Exit to close 
the application.

Now that you are familiar with the concepts of Business Process Testing, the 
Business Components and Test Plan modules, and the Mercury Flight 
Reservations application, you can proceed to Lesson 2, “Creating Business 
Components.” In this lesson, you will learn how to create business 
components in the Quality Center Business Components module.
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2
Creating Business Components

Business components are reusable units that perform a specific task in a 
business process. Components can be manual components or automated 
components. Automated components can be keyword-driven or scripted 
components. 

There are several stages involved in creating a keyword-driven automated 
component. You begin by creating a manual business component in the 
Quality Center Business Components module, define the details that make 
up each component’s shell in the Details tab of the component, and add 
manual steps. At this point, you can add components to business process 
tests and flows, even if the application is not yet ready to be tested. 

As soon as the application is ready to be tested, you can convert your 
component to an automated component, associate it with an application 
area, and add keyword-driven steps to it.

In this lesson, you will learn about:

 ➤  Creating Components on page 32

 ➤  Defining Component Details on page 34

 ➤  Adding Manual Steps on page 36

In later lessons, you will complete the component design process by 
converting your components to automated components, associating them 
with application areas, and adding keyword-driven steps.
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Creating Components

In this section, you create business components for testing the Mercury 
Flight Reservations application.

 1 Open the Business Components module.

If Quality Center is not currently open, open it and log into the 
Quality Center Demo project, as described in “Starting Business Process 
Testing” on page 19.

Click the Business Components module button in the sidebar. The Business 
Components module opens.

 2 Create a folder in which your business components will be stored.

In the component tree, select the Components root folder.

Click the New Folder button in the tree toolbar. 

The New Folder dialog box opens.

Enter BPT_Tutorial in the Folder Name box, and click OK. The new folder is 
added to the component tree.

 3 Add the first business component to the folder.

Ensure that the BPT_Tutorial folder is selected in the component tree and 
click the New Component button in the tree toolbar. The New Component 
dialog box opens.
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Enter Login in the Component Name box and click OK. The new business 
component is displayed under the BPT_Tutorial folder in the component 
tree.

Note: If the project administrator defined required fields in Project 
Customization in Quality Center, the Required Component Fields dialog 
box opens. Select any value for each of the displayed fields. 

Note that the component icon displays an M in the top-left corner, which 
indicates that it is currently a manual component that can only be run 
manually.

The component tabs for the new Login component are displayed on the 
right of the Quality Center window.

 4 Repeat step 3 to create the following business components in the 
BPT_Tutorial folder:

➤ Create Order

➤ Update Order

➤ Logout
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The components are displayed in the component tree in alphabetical order, 
as follows:

Defining Component Details

In this section, you define specific details for each business component that 
you created.

 1 Display the Details tab for the component.

Select the Login component in the component tree and click the Details tab 
if it is not currently displayed.

 2 Provide the component’s general details.

In the Description area, use the default section headings to enter a textual 
description of the Login component’s purpose, and the pre-condition and 
post-condition of the application before and after running the component. 

➤ Summary. Enter an overall description of the component’s purpose or 
contents. For example:
Access the Mercury Flight Reservations application, enter name and 
password, and open the Flight Reservation dialog box. 

➤ Pre-Condition. Describe the point in the flow of the application at which 
the current component starts. For example:
The Flight Reservations application must be closed.

➤ Post-Condition. Describe the point in the flow of the application at 
which the current component ends. For example:
The Flight Reservation dialog box is displayed. 
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Tip: The Details tab provides a comprehensive selection of text editing and 
formatting commands to assist you in entering the component description. 
Right-click in the Description area to access the commands from the context 
menu. Select Toolbar Visible from the context menu to display (or hide) 
commonly used commands in the toolbar.

 3 Repeat steps 1 and 2 to define appropriate details for the other business 
components. 

Set the details of the components according to the table below.

Component Summary Pre-condition Post-condition

Create 
Order

Enter flight details and 
insert an order.

The Flight 
Reservation 
window is active.

The Flight 
Reservation 
window is active.

Update 
Order

Open an existing order, 
modify flight details, 
and update the order.

The Flight 
Reservation 
window is active.

The Flight 
Reservation 
window is active.

Logout Exit the Mercury Flight 
Reservations 
application.

The Flight 
Reservation 
window is active.

The application 
is closed.
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Adding Manual Steps

Now that you have created business components, you can add manual steps 
to them. Manual steps can be used as instructions for testing the application 
manually, or they can be used as guidelines for creating automated steps at a 
later time.

For the purposes of this tutorial, you can be as detailed as desired when 
entering the manual steps. In a real testing environment, manual steps 
should include each individual operation that should be performed on the 
application during the component run as well as additional testing 
operations such as checking that a button is enabled, making sure an image 
appears in a particular location, checking how the application responds to 
invalid data, and so on.

Note: Even if you choose not to add all of the manual steps described in this 
section, or if you decide not to enter all of the details, it is recommended 
that you include at least a few manual steps in each component, because 
some instructions in future sections of the tutorial assume that manual steps 
exist.

You add manual steps in the Design Steps tab of the Business Components 
module. 

 1 Display the Design Steps tab for the component.

Select the Login component in the component tree and click the Design 
Steps tab.
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 2 Perform the first manual step in the Flight Reservations application so that 
you know how to describe it.

The first step in your Login component is to open the Flight Reservations 
application directly from the file system. Perform this step yourself by 
double-clicking the executable file:
<QuickTest Professional installation folder>\samples\flight\app\flight4a.exe
(By default, this path is: C:\Program Files\HP\QuickTest 
Professional\samples\flight\app\flight4a.exe.) The Login dialog box 
opens. 

 3 Enter the first manual step.

In the Design Steps tab, click the New step toolbar button. The Component 
Step Editor opens.

In the Step Name box, enter a descriptive name, for example, Launch Flight 
Application.

In the Description pane, enter a description of the first step of the 
component. For example: 
Open the Mercury Flight Reservation application from C:\Program 
Files\HP\QuickTest Professional\samples\flight\app\flight4a.exe 
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In the Expected Result pane, enter the expected result of performing the 
described step. For example: The Login dialog box opens.

If the step does not produce the expected result when the component is run, 
the component will fail.

Click the New Step button within the Component Step Editor to open a 
blank second step.

 4 Add the remaining manual steps for the Login Component.

Physically perform each of the next steps in the Flight Reservations 
application, as described in “Exploring the Mercury Flight Reservations 
Application” on page 27 (entering a user name, entering a password, 
clicking OK to close the Login dialog box), so that you will know how to 
describe them. 

Then enter a description of the operations you performed in the 
Component Step Editor by adding a name, description and expected result 
of each step and clicking the New Step button. 

 5 Close and Save the Login Component.

When you complete the last step in the component, click OK in the 
Component Step Editor. If you are prompted to save your changes, click Yes.

Click the Save button in the toolbar to save your steps. 

Tip: Save any changes that you make in the Design Steps tab by clicking the 
Save toolbar button. Since changes you make in this tab are not saved 
automatically, it is also recommended that you save them periodically. 

 6 Enter manual steps for the Create Order, Update Order, and Logout 
components.

Repeat steps 1 through 5 to enter manual steps for the remaining 
components. 

➤ The Create Order manual steps should include displaying the Flight 
Reservation window, entering itinerary details, selecting a flight, entering 
order information, and inserting the order.
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➤ The Update Order manual steps should include displaying the Flight 
Reservation window, opening an order (using the order number, not by 
searching for a name or date), modifying the seating class to first class, 
and updating the order.

➤ The Logout manual steps should include displaying the Flight 
Reservation window, and exiting the application.

When entering manual steps, keep in mind that your first and last steps 
should reflect the pre-conditions and post-conditions specified when you 
created the component.

Now that you are familiar with creating components and defining business 
component details, you can proceed to Lesson 3, “Creating Business Process 
Tests.” In this lesson, you will learn how to combine the components you 
have created into a business process test.
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3
Creating Business Process Tests

Business process tests are testing scenarios comprised of a sequence of 
business components. In this lesson, you create a business process test in the 
Test Plan module of Quality Center, using the components you created in 
the Business Components module.

Business process tests can also contain reusable flows of components. For 
more information about flows, see “Working with Flows” on page 108.

Note: For more information about working with the Test Plan module of 
Quality Center, see the HP Quality Center User Guide.

In this lesson, you will learn about:

 ➤  Creating a Business Process Test on page 41

 ➤  Adding Components to a Business Process Test on page 44

Creating a Business Process Test

In this section, you create a new business process test in the test plan tree of 
the Test Plan module.

 1 Open the Test Plan module.

Click the Test Plan module button in the Quality Center sidebar. The Test 
Plan module opens. 
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 2 Create a folder in which your business process tests will be stored.

In the test plan tree, select the Subject root folder.

Click the New Folder button in the toolbar above the test plan tree. The 
New Folder dialog box opens.

In the Folder Name box, enter BPT_Tutorial, and click OK.

The new folder is displayed as a subfolder of the Subject root folder in the 
test plan tree.

 3 Add a new business process test to the folder.

Ensure that the new folder is selected in the test plan tree. Click the New 
Test button in the toolbar above the tree. The Create New Test dialog box 
opens.

From the Test Type list, select BUSINESS-PROCESS.

In the Test Name box, enter Reservation_Test.

Click OK. 
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Note: If the project administrator defined required fields in Project 
Customization in Quality Center, the Required Test Fields dialog box opens. 
Select any value for each of the displayed fields. For more information, see 
the HP Quality Center Administrator Guide.

The new business process test is added to the BPT_Tutorial folder in the test 
plan tree. The business process test tabs are displayed on the right of the 
Quality Center window.

 4 Add a test description.

The Details tab contains both required and optional fields, as well as the 
Description and Comments tabs.

In the Description tab, enter a description for the business process test. For 
example: This test verifies the functionality of the Flight Reservations 
application.
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Adding Components to a Business Process Test

In this section, you build the structure of your business process test by 
selecting the business components you created and adding them to the test. 
You then configure their run settings, and define what the test will do if one 
or more of the components fail.

 1 Display the available components in the Test Script Tab.

The business components you created in the Business components module 
are available for use in the Test Plan module.

Select Reservation_Test in the test plan tree. The test tabs are displayed.

Click the Test Script tab. Ensure that the Components and Flows pane is 
displayed. If it is not displayed, click the Select Component button in the 
Test pane toolbar.

This tab comprises two panes: the Test pane on the left of the tab, and the 
Components and Flows pane on the right. (A business process test can also 
contain flows, as described later in this tutorial.) The Components tab in the 
Components and Flows pane contains the available components in a tree 
hierarchy. 

Note: All business components in the Business Components module, 
created by you or by others, are available for use. This means that 
components can be used in multiple business process tests. For example, the 
Login component you created could be used in any test that opens the 
Mercury Flight Reservations application.
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In the tree in the Components tab, expand the BPT_Tutorial folder that 
contains the components you created. 

Tip: To expand a folder in the component tree, click the Expand symbol  
to the left of the folder name or double-click the folder.

 2 Add components to the test.

Add components to the business process test according to the following 
procedures:

Drag the Login component from the component tree and drop it in the Test 
pane.

Double-click the Update Order component in the component tree to add it 
to the end of the test.

Drag the Create Order component from the component tree and drop it on 
top of the Login component in the Test pane. This inserts the component 
directly below the Login component.

Test Pane

Components Tab 
and Flows Tab
in the 
Components and 
Flows Pane
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Ensure that the Create Order component is selected in the Test pane. Then 
select Logout in the component tree and click the Add Component to Test 
button in the toolbar. This adds the component directly below the Create 
Order component.

 3 Close the Components and Flows pane.

You have added all the required components to your test. 

Click the Close button in the Components and Flows pane toolbar.

 4 Arrange the selected components into a logical testing sequence.

To assist you in arranging your components, you can review the 
implementation instructions, and the pre- and post-conditions of each 
component directly from the bottom of the Test pane. Select a component 
in the Test pane and click the Show button at the bottom right of the pane. 
The Description tab displays the information you entered in the Details tab 
of the component in the Business Components module.

Update Order is currently positioned as the last component in the test. 
When you run the test, the Logout component must be the last component.
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Select Update Order in the Test pane and click the Up button in the toolbar 
once. This moves Update Order above the Logout component.

 5 Save the Business Process Test.

Click the Save button in the tab toolbar to save your new business process 
test.

Defining Failure Conditions

If the failure of a particular component means that later components in the 
test cannot possibly run successfully, or that there is simply no point in 
continuing the test run after a failure, you can instruct the business process 
test to end at that point.

In this section, you define the condition that instructs your test to stop 
running if the Login component fails to open the Flight Reservations 
application.

 1 In the Test pane of the Test Script tab, click in the On Failure column for the 
Login component. A down arrow is displayed. (You may have to scroll to the 
right or resize your columns to view this column.)
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 2 Click the down arrow and select Exit from the list. This defines that your 
business process test will end if the Login component fails.

Note: By default, Continue is defined for each business component when it 
is added to a business process test. This means that the test will run the next 
component even if the specific component fails.

 3 Save the Business Process Test.

Click the Save button in the tab toolbar to save your new business process 
test.

You have now finished the first phase of business process testing. You 
created business components with manual steps, and combined those 
components into a business process test. At this point, you can already 
perform manual tests on your application. 

You are also ready to begin the next phase of business process testing: 
automating your components. The next two lessons will teach you how to 
convert your manual components to automated components and add 
keyword-driven steps to them. 

This tutorial does not describe manual business process test runs. For more 
information, see the HP Business Process Testing User Guide.
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4
Automating Components

Before you can add automated steps to a keyword-driven business 
component, you must convert the component to an automated component. 
You then associate it with an application area that contains all of the 
relevant objects contained in the application as well as any special functions 
or recovery scenarios that you may need to access. 

When you create the steps of a business component, the objects stored with 
the application area are displayed for selection in an object repository tree, 
which provides a view of all the available objects in the application. For 
example, an object repository tree in a Flight Reservation business 
component could contain:

It is important to note that when the business component runs, the context 
of each step in the component must be set by an earlier step or steps. This 
means that for an operation on an object to be performed successfully, the 
object must be currently displayed in the application you are testing.

In this lesson, you will learn about:

 ➤  Converting Components to Automated Components on page 50

 ➤  Selecting Application Areas on page 52

➤ Dialog boxes

➤ Text boxes

➤ Buttons

➤ List Boxes

➤ Radio buttons
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Converting Components to Automated Components

In this section, you access the Design Steps in the Business Components 
module and convert each of the manual business components you created 
in Lesson 2, “Creating Business Components,” to automated components. 

Note: You cannot modify the manual steps in your components after they 
are automated.

 1 Display the Design Steps tab for the Login component.

In the Business Components module, select the Login component in the 
component tree and click the Design Steps tab. The Design Steps tab opens.

 2 Automate the component.

Click the Automate component toolbar button. 

Select QuickTest Keyword-Driven from the list and click Yes in the warning 
message. The component is converted to an automated QuickTest 
component. 

Click OK in the information message and then click the Automation tab.
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Note: The first time you click the Automation tab in a new project, and the 
QuickTest Professional for Business Process Testing Add-in is installed, 
predefined project resources are created. These resources are displayed in the 
BPT Resources folder in the Test Resources module. During the creation 
process, the Creating Predefined Business Process Testing Resources progress 
bar is displayed. This may take a few seconds to complete. 

In the Automation tab, the steps appear as manual step operations. (These 
are useful for providing implementation instructions and summary 
information. In Lesson 5, “Adding Keyword-Driven Component Steps,” you 
will learn how to replace these manual operation steps with automated 
keyword-driven steps.) 

Tip: You can select the columns to display in the Automation tab, specify 
their order, and set the number of columns that remain stationary when 
you scroll horizontally. For more information about setting keyword view 
options, see the HP Business Process Testing User Guide.

 3 Automate the remaining components.

Repeat steps 1 and 2 to automate the Create Order, Update Order, and 
Logout components.
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Selecting Application Areas

Each keyword-driven component must be associated with an application 
area. The application area determines the objects and operations that are 
available for your component as well as other default settings, such as 
associated add-ins, recovery scenarios, the Windows-based applications on 
which your component can run, and more. 

The application area is usually created by the Automation Engineer in 
consultation with the Subject Matter Experts who will be using it. In this 
tutorial, you use a ready-made application area that was created for you.

 1 Select the application area for the Login component.

In the Business Components module, select the Login component and click 
the Automation tab, if it is not already displayed.

Click the Select Application Area button in the Automation tab toolbar. The 
Select Application Area dialog box opens.

Ensure that Flight_Application_Area is the currently selected application 
area for the business component.
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Click OK. The Select Application Area dialog box closes. The name of the 
associated application area (Flight_Application_Area) is displayed in the 
Automation tab toolbar.

 2 Save the component.

Click the Save button in the Automation tab toolbar to save the Login 
component.

Tip: Changes that you make in this tab are saved automatically only when 
you select another tab in the component, another location in the 
component tree, or another module. It is recommended that you save your 
changes by clicking the Save button periodically while you work. 

 3 Select the Flight_Application_Area application area for the other 
components.

Different components can be associated with different application areas 
even if they are part of the same business process test. However, in this 
tutorial, the Create Order, Update Order and Logout components all use 
Flight_Application_Area.

Repeat steps 1 and 2 to select the Flight_Application_Area application area 
for the Create Order, Update Order, and Logout components.

Now that you are familiar with automating components and associating 
business components with application areas, you can proceed to Lesson 5, 
“Adding Keyword-Driven Component Steps.” In this lesson, you will learn 
how to create the sequential keyword-driven steps that comprise your 
business components. 
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5
Adding Keyword-Driven Component 
Steps

In Lesson 2, “Creating Business Components,” you created manual steps 
that described the operations that each component should perform. In 
Lesson 4, “Automating Components,” you converted these manual steps to 
manual step operations. In this lesson, you can use your manual step 
operations as a guide for adding automated keyword-driven steps to your 
business components.

Each step you create in a business component is displayed as a row in the 
Automation tab of the Business Components module. You add automated 
keyword-driven steps by selecting specific objects from the object repository, 
which is part of the application area. You then select the object (if 
applicable) and operation to be performed and define any required 
operation values. 

Quality Center automatically documents the steps in the Automation tab, 
providing a plain-language textual description of what the step does.

For sequential business components to run successfully in a business process 
test, the state of the application at the end of one component (its 
post-conditions) must always match the required state of the application at 
the beginning of the next component (the subsequent component’s 
pre-conditions).

Similarly, if you want a business component to run multiple iterations 
during the test, the application’s end state must match its state at the 
beginning of the component. This means that the first step of the 
component can be repeated immediately after the last step of the previous 
component iteration.
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In this lesson, you will learn about:

 ➤  Creating Automated Steps for the Login Component on page 56

 ➤  Creating Automated Steps for the Create Order Component on page 64

 ➤  Creating Automated Steps for the Update Order Component on page 71

 ➤  Creating Automated Steps for the Logout Component on page 75

Creating Automated Steps for the Login Component

In this section, you identify and create automated keyword-driven steps in 
the Login business component. This component logs the user into the Flight 
Reservations application.

As you can see from the information you entered previously in the Details 
and Design Steps tabs, logging in to the application requires the following 
individual actions:

➤ Opening the Flight Reservations application

➤ Entering the agent’s name and password in the Login dialog box

➤ Closing the dialog box

The pre-condition for this business component is that the application is not 
currently running on your computer.
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 1 Open the Login component in the Business Components module.

Select the Login component in the component tree and click the 
Automation tab if it is not currently displayed. 

 2 Add the step to launch the Flight Reservations application and open the 
Login dialog box. 

This step in the component provides the path to the Flight Reservations 
application and activates the Login dialog box.

Note: You may have chosen not to add all the manual steps when creating 
your components. If so, remember that any automated step you add is 
inserted into the test after the selected step. 

Highlight the manual operation for opening the Mercury Flight 
Reservations application and click the Add Step button in the Automation 
tab toolbar. A new step is added below the manual operation step, and the 
Select an item menu opens.

Select Operation from the list. The Operation item is inserted in the step. 

Click in the Operation column of the new Operation step. A down arrow is 
displayed.

Click the arrow, and select OpenApp from the list.
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Click in the Value column, and then enter the location of the Flight 
Reservations application:
<QuickTest Professional installation folder>\samples\flight\app\flight4a.exe

(By default, this path is: C:\Program Files\HP\QuickTest 
Professional\samples\flight\app\flight4a.exe)

 3 Display the Login dialog box objects.

In the Automation tab, select the step containing the manual operation for 
entering a user name and click the Add Step button in the Automation tab 
toolbar. A new step is added below the manual operation and the Select an 
item menu opens. 

Select Login Dialog. The Login Dialog object is inserted as the item in the 
step, and the default operation for the item, Activate, is automatically 
inserted in the Operation cell for the step. This step ensures that the parent 
Login dialog box object is active, and that the child objects within the 
dialog box are displayed for selection in the Select an item menu. 
Subsequent steps can then be created to perform operations on the child 
objects.

 4 Add the other login steps to the component.

You can now add the Agent Name and Password text box objects as steps in 
the component.

Select the Login Dialog step in the Automation tab and click the Add Step 
button in the Automation tab toolbar. A new step is added to the tab, and 
the Select an item menu opens.
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Note: The Select an item menu displays objects in the object repository that 
are siblings (at the same level), or children (at levels below), of the object in 
the selected step. 

Select Agent Name. The Agent Name text box object is inserted as the item 
for the step. The default operation for the item, in this case, Set, is 
automatically inserted in the Operation column.

In the Value column, enter mercury.

Select the step containing the manual operation for entering a password and 
click the Add Step button in the Automation tab toolbar. A new step is 
added to the tab and the Select an item menu opens. 

Select Password. The Password text box object is inserted as the item in the 
step. The default operation for the item, Set, is automatically inserted in the 
Operation cell.

In the Value cell, enter mercury.

Note: The Operation list also offers a SetSecure operation. This operation 
enables you to enter password values in an encrypted format. You can 
generate the encrypted value using the Password Encoder tool supplied with 
QuickTest. However, for the purposes of this tutorial, you are leaving the 
password unencrypted by using the Set operation.

Select the step containing the manual operation for clicking the OK button, 
and click the Add Step button in the Automation tab toolbar. A new step is 
added to the tab and the Select an item menu opens. 

Select OK. The OK button object is added to the step in the Automation tab. 

The default operation for the item, Click, is automatically inserted in the 
Operation column.

This final step opens the Flight Reservation dialog box. This is the 
pre-condition for running the next component, Create Order.
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 5 Review your component.

Look at the Documentation column in the Automation tab. (You may need 
to scroll to the right to see the entire column). Review the documentation 
that was automatically generated for each step you entered to ensure that 
the steps make sense and follow a logical order.

The Automation tab for the Login component should appear similar to the 
following.

Click the Design Steps tab. 
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Each of your original manual steps is followed by the equivalent automated 
step.

 6 Save the component.

Reopen the Automation tab and click the Save button in the toolbar to save 
the Login component.
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Deleting Manual Step Operations
The manual steps that you originally created in the Design Steps tab 
provided summary information or implementation instructions about the 
component and have no actual effect on the automated test run. Since your 
manual steps were mainly guides to what needed to be implemented in the 
automated steps, they are no longer necessary.

Therefore, after you implement the automated steps in your component, 
you may want to delete some or all of the manual step descriptions (now 
manual step operations) from the component to make it easier to read. 

 1 Delete the manual steps.

In the Automation tab, highlight the first manual step operation in the 
Login component and click the Delete Step button. Click Yes on the 
warning message. Repeat for each manual operation in your component 
that you want to delete.

 2 Save the component.

Click the Save button in the Automation tab toolbar to save the Login 
component.
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 3 Review the automated keyword-driven steps in the Automation tab.

 4 Review the automated steps in the Design Steps tab. 

The steps in this tab are now read-only and can be changed only by 
modifying (or adding to) the steps in the Automation tab.
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Creating Automated Steps for the Create Order Component

In this section, you identify and create automated keyword-driven steps in 
the Create Order business component. This component reserves a specific 
flight for a passenger and creates an order number in the system. 

The steps in this component use the Flight Reservation dialog box:

Creating the order requires the following individual actions:

➤ Displaying the Flight Reservation objects

➤ Entering flight schedule requirements

➤ Selecting an available flight

➤ Entering order information

➤ Creating the order in the system

➤ Retrieving the generated order number and storing it for later use
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The pre-condition for this business component is that the Flight Reservation 
window is currently displayed. This condition is answered by the Login 
component that runs before the Create Order component in the test and 
opens the application.

 1 Open the Create Order component in the Business Components module.

Select the Create Order component in the component tree and click the 
Automation tab if it is not currently displayed. 

 2 Add the steps to display the Flight Reservation objects and clear any dialog 
box values. 

The first step in the component ensures that the Flight Reservation dialog 
box is active. The next step clears any data that may have been entered by a 
previous iteration of this component or another component that may 
perform operations on this dialog box earlier in a test.

Select the first manual operation in the component and click the Add Step 
button in the Automation tab toolbar. A new step is added to the tab and 
the Select an item menu opens.

Select Flight Reservation Dialog from the list. The Flight Reservation Dialog 
object is inserted as an item in the step, and the default operation for the 
item, Activate, is automatically inserted in the Operation cell. 

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab, and the Select an item menu opens.

Scroll down to Toolbar.New Order Button in the list (the list is in 
alphabetical order) and select it. Accept the default Click operation. This step 
clicks the New Order button and clears any data in the Flight Reservations 
window, making it ready to accept new order details. This is particularly 
important as it enables this component to be iterated. 
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 3 Add the steps to enter flight schedule requirements. 

Now you create the component steps that enter the information required to 
select a specific flight: the required flight date, the starting point, and the 
destination.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select OrderInformation.Date of Flight. This item enables the required 
departure date to be inserted in the Date of Flight text box. Accept the 
default Set operation. In the Value column, enter a date later than the 
current date in the format mm/dd/yy.

Repeat the steps in this procedure to add the following steps after the step 
you just inserted: 

 4 Add the step to display the Flights table.

Now you add the component step that opens the Flights table containing 
the available flights according to the flight schedule requirements.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select Flight Schedule.Flights. Accept the default Click operation. 

 5 Add the steps to select an available flight.

The next steps open the Flights Table dialog box and select an available 
flight.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Item Operation Value

 Flight Schedule.Fly From Select San Francisco

 Flight Schedule.Fly To Select Zurich
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Select Flights Table Dialog from the list. Accept the default Activate 
operation.

Click the Add Step button in the Automation tab toolbar. A new step is 
added to the tab and the Select an item menu opens.

Select OK Button. Accept the default Click operation. This step clicks the OK 
button to accept the first available flight listed in the Flights Table dialog 
box. 

 6 Add the steps to display the Flight Reservation dialog box. 

The objects required for the following steps are located in the Flight 
Reservation dialog box. This step reactivates the Flight Reservation dialog 
box.

Select the next manual operation or the last step you added and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab, and the Select an item menu opens.

Flight Reservation Dialog is not a sibling or child object of the OK Button 
object, and is therefore not displayed in the Select an item list.

Select Select another object from the list. The Select Object for Step dialog 
box opens.
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Select Flight Reservation Dialog in the Object repository tree and click OK. 
The Select Object for Step dialog box closes and the Flight Reservation 
dialog box step is added with the default Activate operation.

 7 Add the step to enter order information.

This step enables the passenger name and class details to be defined for the 
selected flight. 

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select Order Information.Name. This item enables the passenger name to be 
inserted into the Name text box. Accept the default Set operation and enter 
J. Jones in the Value column.

 8 Add the step to create the order in the system.

This step reserves the flight according to the specified details and creates an 
order number in the system.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select Order Information.Insert Order Button. Accept the default Click 
operation. 

 9 Add the step to retrieve the generated order number and store it for later 
use.

When a new order is inserted in the Flight Reservation dialog box, it 
generates an order number. This order number can potentially be useful for 
other testing tasks in other components. Therefore, it makes sense to 
retrieve this value and store it.

In this step, you store the retrieved value in a local variable. In Lesson 7, 
“Working with Parameters,” you will learn how to store this value in a 
component parameter so that other components can use the retrieved 
value.



Lesson 5 • Adding Keyword-Driven Component Steps

69

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select the Order No text box. The default operation for the item, Set, is 
automatically inserted in the Operation column. Change the operation to 
GetValue by selecting it from the Operation list.

Click in the Output cell in this step, and then click the Specify parameter 
for output button. 

In the Output Options dialog box, accept the Local Parameter output type. 
Enter the parameter name, Temp_OrderNo_Out, and for the description, 
enter Temporary output parameter for storing the retrieved order number. 

Click OK to close the Output Options dialog box.

 10 Delete any unnecessary manual steps.

If desired, you can delete the manual steps as described in “Deleting Manual 
Step Operations” on page 62.

 11 Review the auto-documentation for the component.

Read through the statements in the Documentation column to ensure that 
the steps make sense and follow a logical order.

 12 Save the component.

Click the Save button in the Automation tab toolbar to save the Create 
Order component.
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The steps in the Automation tab for the Create Order component should 
appear similar to the following:

Note: The above Create Order business component will not run successfully 
as shown because it contains an intentional error. Specifically, QuickTest 
will be unable to retrieve a number for the Temp_OrderNo_Out parameter 
(the last step in the component). This is because QuickTest will try to 
perform the GetValue step immediately after it clicks the Insert Order 
button in the previous step, and before the Mercury Flight Reservations 
application has had sufficient time to insert the order. How this issue is 
detected and resolved is described in “Debugging the Parameterized Test” on 
page 102.
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Creating Automated Steps for the Update Order 
Component

The order you created in the Create Order business component reserved an 
Economy Class seat for passenger J. Jones. In this section, you identify and 
create the automated keyword-driven steps in the Update Order 
component. This component reopens this order and upgrades the 
reservation to First Class. 

Updating the order requires the following individual actions:

➤ Locating the order to be updated

➤ Opening the order

➤ Making the required changes

➤ Updating the order

The pre-condition for this business component is that the Flight Reservation 
window is currently displayed.

 1 Open the Update Order component in the Business Components module.

Select the Update Order component in the component tree and click the 
Automation tab if it is not currently displayed. 

 2 Add the steps to access the Open Order dialog box. 

These steps capture the order number of the order you created in the Create 
Order component.

Select the first manual operation in the component and click the Add Step 
button in the Automation tab toolbar. 

A new step is added to the tab and the Select an item menu opens.
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Select Flight Reservation Dialog from the list and accept the default Activate 
operation. Adding this step ensures that the Flight Reservation dialog box is 
active. 

The following step selects the File menu in the Flight Reservation dialog box 
and chooses the Open Order command.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab, and the Select an item menu opens.

Select Menu. Accept the default Select operation. In the Value column, enter 
the following exactly as shown: File;Open Order...
This data is case-sensitive.

 3 Add the steps to open the order to be updated.

To enhance the reusability of your Update Order component, you can 
designate the order number as a parameter. This enables each test that uses 
the component to assign a different value to use. 

In these steps, you use a local parameter (variable) value. In Lesson 7, 
“Working with Parameters,” you will change the local parameter to a 
component parameter so that you can retrieve the order number value from 
another component.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab, and the Select an item menu opens. 

Select Open Order Dialog. Accept the default Activate operation. Adding 
this step ensures that the Open Order dialog box is active. 

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens. 

Select the Order No check box. Accept the default Set operation. In the 
Value column, enter ON. This step places a check mark in the Order No 
check box in the Open Order dialog box, which enables the number of the 
required order to be inserted. 
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Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab, and the Select an item menu opens. 

Select Order Number Edit. Accept the default Set operation.

Click in the Value cell for this step and click the Configure the value button. 
In the Value Configuration Options dialog box, select the Parameter radio 
button. Local Parameter is displayed in the corresponding text box. In the 
Name box, enter Temp_OrderNo_In. In the Value box, enter 3. In the 
Description box, enter Temporary input parameter representing the retrieved 
order number. 

In Lesson 7, “Working with Parameters,” you will change this local 
parameter to a component input parameter that is defined to retrieve the 
value from output value step of the Create Order component.

Click OK to close the Value Configuration Options dialog box.

 4 Add the step to close the Open Order dialog box.

This step closes the Open Order dialog box and displays the order details in 
the Flight Reservation dialog box.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select OK Button. Accept the default Click operation.

In the following steps, you make a change to the original reservation you 
created.

 5 Add the step to display the Flight Reservation dialog box. 

The objects required for the following steps are located in the Flight 
Reservation dialog box. This step ensures that the Flight Reservation dialog 
box is active.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.
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Flight Reservation Dialog is not a sibling or child object of the Open Order 
Dialog object, and is therefore not displayed in the Select an item list.

Select Select another object from the list. The Select Object for Step dialog 
box opens.

Select Flight Reservation Dialog in the Object repository tree and click OK. 
The Select Object for Step dialog box closes. 

Accept the default Activate operation.

 6 Add the steps to update the order.

These steps update the order by changing the passenger class.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.

Select Order Information.Class.First. Accept the default Set operation. This 
step selects the First Class radio button.

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab and the Select an item menu opens.
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Select Order Information.Update Order Button. Accept the default Click 
operation. This step clicks the Update Order button, which updates the 
order with the changed data.

 7 Delete any unnecessary manual operations.

If desired, you can delete the manual operations, as described in “Deleting 
Manual Step Operations” on page 62.

 8 Save the component.

Click the Save button on the Automation tab toolbar to save the Update 
Order component.

The steps in the Automation tab for the Update Order component should 
appear similar to the following:

Creating Automated Steps for the Logout Component

In this section, you identify and create the automated keyword-driven steps 
in the Logout business component. This component exits the Flight 
Reservations application. 

You exit the application using the File menu in the Flight Reservation dialog 
box. Exiting the Flight Reservations application requires the following 
individual actions:

➤ Displaying the Flight Reservation dialog box

➤ Selecting the Exit option
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The pre-condition for this business component is that the Flight Reservation 
window is currently displayed.

 1 Open the Logout component in the Business Components module.

Select the Logout component in the component tree and click the 
Automation tab if it is not currently displayed. 

 2 Add the step to display the Flight Reservation dialog box.

Adding this step ensures that the objects in the Flight Reservation dialog 
box are displayed in the Select an item menu. 

Select the first manual operation and click the Add Step button in the 
Automation tab toolbar. A new step is added to the tab, and the Select an 
item menu opens.

Select Flight Reservation Dialog from the list. Accept the default Activate 
operation.

 3 Add the step to select the Exit command from the File menu. 

Select the next manual operation or the step you just inserted and click the 
Add Step button in the Automation tab toolbar. A new step is added to the 
tab, and the Select an item menu opens.
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Select Menu. Accept the default Select operation. Click in the Value cell for 
this step and enter the following, exactly as shown: File;Exit
This data is case-sensitive.

 4 Delete any unnecessary manual steps.

If desired, you can delete the manual operations as described in “Deleting 
Manual Step Operations” on page 62.

 5 Save the component.

Click the Save button on the Automation tab toolbar to save the Logout 
component.

The steps in the Automation tab for the completed Logout component 
should appear similar to the following:

Your business components are now ready to run. In the next lesson, you will 
perform a debug run on your business process test to ensure that all of your 
components run successfully.
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6
Debugging Business Process Tests

You check for any problems arising from the content of automated business 
components, and their combination in a business process test, by running 
the test in debug mode. Debugging helps you to check whether your 
business process test runs properly, and locates any possible errors that may 
have occurred during the building of the test. For example, you may want to 
check that the business components are in a logical order in the test, and 
that the pre-conditions and post-conditions required by each component 
are applied correctly. 

When the debug run begins, Quality Center opens QuickTest Professional 
directly from the Test Plan module. If the first component in the test has 
any add-ins associated with it, those add-ins are loaded when QuickTest 
opens. However, for the components in this tutorial, no add-ins are 
necessary. 

During the debug run, QuickTest performs each of the automated steps that 
you created in your business components. Then, when the test is complete, 
you can view a summarized report that shows which of the business 
components passed or failed the test.

In “Debugging Your Business Process Test” on page 81, you check that the 
individual business components you created run together successfully in the 
business process test. 
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Important: 

➤ You must have QuickTest Professional version 10.00 installed on your 
computer to run a business process test in the Test Plan module. In 
addition, before you run a business process test on a host computer, you 
must ensure that QuickTest Professional on the host allows 
Quality Center to run tests. Open QuickTest on the host computer, select 
Tools > Options, click the Run node, and select Allow other HP products 
to run tests and components.

➤ Before you run a business process test, you must ensure that all the 
necessary applications for the test are set up to meet the pre-conditions 
required by the first business component. In this case, the Login 
component opens the Flight Reservations application, so you must close 
any instance of the application that may be open. You must also ensure 
that QuickTest is not open on your computer with any unsaved test or 
component.
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Debugging Your Business Process Test

Now that you created a business process test (Lesson 3, “Creating Business 
Process Tests”), automated your components by converting your manual 
steps to manual step operations (Lesson 4, “Automating Components”), and 
added automated keyword-driven steps to your components (Lesson 5, 
“Adding Keyword-Driven Component Steps”), you are ready to debug your 
test. 

Note: The debug run described here updates the passenger class of order 
number 3 in the Mercury Flight Reservations sample database. If this test 
has been run before, ensure that the details of order number 3 have been 
reset. Open the Mercury Flight Reservations application and select File > 
Open Order to open the Open Order dialog box. Select Order No and 
enter 3 in the text box. Click OK to open order number 3, select Economy in 
the Class area of the Flight Reservation dialog box and click Update Order.

 1 Open the Test Plan module.

Click the Test Plan module button in the Quality Center sidebar. The Test 
Plan module opens. 

 2 Display the components in the test.

Ensure that the Reservation_Test business process test is selected in the test 
plan tree, and that the Test Script tab is displayed. 

 3 Set all components to exit on failure.

While editing and debugging your test, it is a good idea to set all 
components to exit the test run if one of the components fail. That way, if a 
component fails, you do not have to wait for all other components to run 
before trying to solve the problem. After your test is finalized and ready to 
be run in a test set, you can return the exit conditions to their previous 
settings.

In the On Failure column, select Exit for each of the components.
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 4 Save the component.

Click the Save button in the toolbar to save your changes.

 5 Run the test.

Click the Run or Debug Test button in the Test Script toolbar.

The Run or Debug Test dialog box opens, listing all of the components that 
comprise the selected business process test.

When you set a component to Normal mode, the component runs from 
start to finish without pausing and continues immediately to the next 
component in the test. When you run a component in Debug mode, a 
breakpoint is added that causes the business process test to pause before 
running the first step in the selected component. For more information 
about selecting Debug mode or Normal mode in the Run or Debug Test 
dialog box, see the HP Business Process Testing User Guide.

For the purposes of this lesson, you are checking that the test as a whole 
runs smoothly. Therefore, leave all components set to Normal mode.

Click OK to close the Run or Debug Test dialog box. QuickTest Professional 
opens on your computer and runs the first component in the business 
process test. 
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Note: If QuickTest displays a permissions error when you begin the run, 
ensure that QuickTest Professional allows Quality Center to run tests, as 
described in the note on page 80.

 6 View the progress of the test.

Toggle between the Test Plan module, QuickTest, and the Flight Reservations 
application by clicking the relevant buttons on the task bar.

➤ In the Test Plan module, the status of the business process test and the 
name of the component currently being run are shown below the toolbar 
in the Test Script tab, for example, Running (Login).

➤ In QuickTest Professional, the status of the business process test being 
run, for example Running, or Ready, is shown in the status bar at the 
bottom-right of the QuickTest window.

When one component finishes running, it closes, and the next component 
in the business process test opens in QuickTest.

 7 Complete the run.

When the debug run is complete, Quality Center imports the results from 
QuickTest and displays summary information in the Debug Run 
Information dialog box in the Test Plan module. 
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You can see that all of your components ran successfully. Click Close to 
complete the test run.

Note: The debug run updated the passenger class of order number 3 in the 
Mercury Flight Reservations sample database. To run this test again, or to 
prepare the data for the next user, open the Mercury Flight Reservations 
application and select File > Open Order to open the Open Order dialog 
box. Select Order No and enter 3 in the text box. Click OK to open order 
number 3, select Economy in the Class area of the Flight Reservation dialog 
box and click Update Order.
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7
Working with Parameters

In this lesson, you will learn how to define and use input and output 
component parameters. Input component parameters enable you to retrieve 
data from a source outside the steps of a flow or component. The values may 
be supplied by the test containing the flow or component, the test set that 
runs a particular test, or data retrieved from another flow or component in 
the test. Output component parameters are data values that are retrieved 
from a component step in one business component (the source) and can be 
passed as input parameters to a subsequent flow or component (the target) 
in the business process test. 

Parameterization greatly increases the power and flexibility of your 
component, flow or business process test by letting you check how your 
application performs the same operations with multiple sets of data.

This lesson also describes how to create flows and groups, and how to use 
parameters in iterated flows and groups to control the way your test runs.

In this lesson, you will learn about:

 ➤  Defining an Output Component Parameter for the Create Order Component 
on page 86

 ➤  Defining Input Parameters for the Create Order and Update Order 
Components on page 88

 ➤  Creating the Delete Order Component and Adding It to Your Test on page 92

 ➤  Iterating Components on page 96

 ➤  Debugging the Parameterized Test on page 102

 ➤  Working with Flows on page 108

 ➤  Grouping Components on page 120
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Defining an Output Component Parameter for the Create
Order Component

In this section, you define the name, value type, and description of a new 
output parameter for the Create Order business component. You then 
modify the GetValue step in the component to return and store the current 
order number in the new parameter. The value of this parameter will be the 
number of the order that is updated by the Update Order component in the 
test run.

 1 Open the Create Order component in the Business Components module.

Click the Business Components module button in the sidebar. The Business 
Components module opens.

Select the Create Order component in the component tree and click the 
Parameters tab.

 2 Create a new output parameter for the Create Order component.

In the Output pane toolbar, click the New Output Parameter button. The 
New Parameter dialog box opens:

Enter Order_No_Out in the Parameter Name box and click OK. 

A line for the new output component parameter is added in the Output 
parameter list.
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String is entered automatically in the Value Type cell. 

 3 Define the parameter details.

Select the Value Type cell for the component parameter and select Number 
from the list.

In the Description cell, enter the following description for the component 
parameter: The retrieved reservation order number. 

 4 Store the reservation order number in the Order_No_Out component 
parameter.

Click the Automation tab. 

Click in the Output column of the Order No/GetValue step. Two buttons are 
displayed to the right of the parameter name. 

Click the Specify parameter for output button to open the Output Options 
dialog box.

Select Component parameter in the Output Types box. Because only one 
component parameter has been defined, Order_No_Out is automatically 
displayed in the Parameter box. 
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Click the down arrow to display the description you entered in step 3, in 
read-only format.

Click OK. The Output Options dialog box closes.

 5 Save the changes to your component.

Click the Save button on the Automation tab toolbar. 

Defining Input Parameters for the Create Order and Update 
Order Components

In this section, you insert two input component parameters. The first 
accepts data provided at the test level so that each test using the component 
can provide different data. The second parameter retrieves its data from the 
output value of a previous component.

Using Test Data as Input
In this section, you create a new input parameter in which you can define 
various destination cities in the Create Order component. This component 
parameter replaces the fixed value, Zurich, that you defined previously.

 1 Display the component Parameter tab.

Click the Business Components module button in the sidebar. The Business 
Components module opens.

Select the Create Order component in the component tree, and click the 
Parameters tab.
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 2 Create a new input parameter for the Create Order component.

In the Input pane toolbar, click the New Input Parameter button. The New 
Parameter dialog box opens:

Enter Destination in the Parameter Name box and click OK. A line for the 
new input component parameter is added in the Input parameter list. String 
is entered automatically in the Value Type cell. 

In the Default Value cell, enter Zurich. This is the value that will be used if no 
value is provided by the test using the component.

In the Description cell, enter a description of the component parameter’s 
purpose, or other descriptive text, such as the valid values for the parameter. 
For example, Destination cities. Possible values: Denver, Frankfurt, London, Los 
Angeles, Paris, Portland, San Francisco, Seattle, Sydney, Zurich.

 3 Change the destination city from a fixed value to a component parameter.

Click the Automation tab.

In the Flight Schedule.Fly To step, click in the Value cell. The Configure the 
value button is displayed. Click the button. The Value Configuration 
Options dialog box opens.
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Click the Parameter radio button and ensure that Component parameter is 
selected. Click the down arrow next to the Destination parameter name to 
display the description of the parameter you created in step 2.

Click OK. The Value Configuration Options dialog box closes.

Note: If you click in the Value cell of a component parameter in the 
Automation tab, the component parameter icon  is displayed.

 4 Save the changes to your component.

Click the Save button on the Automation tab toolbar.

Click the Test Plan module button in the sidebar to open the Test Plan 
module. Select Reservation_Test in the test plan tree, and click the Test 
Script tab if it is not currently displayed. The input parameter you created, 
and a link, are displayed in the Input column.

If you do not see the new parameter, click the Refresh button in the Test 
pane toolbar. 

When you move the cursor over the link, the cursor changes to a pointing 
hand. Later in this lesson, you will click this link to configure other 
parameter values.

Input 
Parameter
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Using Output Parameters as Input
Earlier in this lesson, you created a step that stores the generated order 
number from the Create Order component in an output component 
parameter. Now you will modify the step in the Update Order component 
that opens an order so that it can retrieve the order number from the Create 
Order output parameter.

 1 Open the Update Order component in the Business Components module.

Click the Business Components module button in the sidebar. The Business 
Components module opens.

Select the Update Order component in the component tree and click the 
Parameters tab. 

 2 Create a new input parameter for the Update Order component.

In the Input pane toolbar, click the New Input Parameter button. The New 
Parameter dialog box opens. Enter Order_Number_In in the Parameter Name 
box and click OK. A line for the new input component parameter is added in 
the Input parameter list. 

String is entered automatically in the Value Type cell. Change the value type 
to Number by selecting it from the list.

In the Default Value cell, enter 3. This is the value that will be used if no 
value is provided by the test using the component. In the Description cell, 
enter: The flight reservation order to open.

 3 Parameterize the Order Number Edit Step.

Click the Automation tab and locate the Order Number Edit step.

Click in the Value cell, and then click the Configure the value button. The 
Value Configuration Options dialog box opens and shows the local 
parameter that you defined in Lesson 5, “Adding Keyword-Driven 
Component Steps.”
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From the Parameter list, select Component parameter. Click the down 
arrow next to the parameter name to display the description of the 
parameter you created in step 2.

Click OK. The Value Configuration Options dialog box closes and the value 
cell displays a component parameter icon.

Later, you will configure this parameter to use the output value generated by 
the Create Order component.

 4 Save the changes to your component.

Click the Save button on the Automation tab toolbar.

Creating the Delete Order Component and Adding It to 
Your Test

In this section, you create a new business component whose properties and 
steps are based on an existing component. This component deletes the order 
created and updated during the run of your business process test.

Deleting an order requires the following individual actions:

➤ Locating the order to be deleted

➤ Opening the order

➤ Deleting the order

These steps are similar to the steps that you used in the Update Order 
business component. Quality Center enables you to quickly create a new 
component by copying an existing component. You can then use the 
settings and steps of the original component as the basis for the new 
component. 

You create the new Delete Order component based on the existing Update 
Order component, and then change the steps of the new component as 
required.
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 1 Make a copy of the Update Order component.

Select Update Order in the component tree, right-click, and select Copy.

Right-click the BPT_Tutorial folder in the component tree and select Paste. A 
duplicate component name warning is displayed. Click OK. A copy of the 
Update Order component, named Update Order_Copy_1, is pasted in the 
component tree.

Right-click the new component and select Rename. Enter Delete Order as the 
name of the component and click on another location to save the new 
name.

Click the Automation tab for the Delete Order component if it is not already 
displayed. Note that this component uses the same input parameter as the 
Update Order component to open the order number that was originally 
generated in the Create Order component. Only the steps specific to 
updating the order itself need to be changed.

 2 Delete the step not required by Delete Order.

The Order Information.Class.First radio button step is not required in the 
Delete Order component. 

Select the Order Information.Class.First step and click the Delete Step 
button in the toolbar. A warning message is displayed. Click Yes.

 3 Change the Update Order Number step to a Delete Order step.

In this component, the Delete Order button must be clicked instead of the 
Update Order button. Select Order Information.Update Order Button in the 
Item column. A down arrow is displayed. Click the arrow and select Order 
Information.Delete Order Button from the list to change the button item 
that will be clicked in the step. Keep the default Click operation.

 4 Add additional steps.

Deleting an order in the Flight Reservations application opens a 
confirmation message box. You must add the following additional steps to 
the Delete Order component to respond to the message and close the 
message box.

Select the empty row after the last step. The Select an item menu opens.
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Select Delete Flight Reservations from the list. This step ensures that the 
Flight Reservations warning dialog box is active. The Delete Flight 
Reservations object is added to the step in the Automation tab, and the 
default operation for the item, Activate, is automatically inserted in the 
Operation cell for the step. 

Click the Add Step button in the toolbar. A new step is added to the tab and 
the Select an item menu opens.

Select Yes Button. Accept the default Click operation. This step clicks the Yes 
button to confirm the deleted reservation.

 5 Save the Delete Order business component.

Click the Save button on the Automation tab toolbar to save the Delete 
Order component.

The Automation tab for the completed Delete Order component should 
appear similar to the following:

 6 Open the test in Test Plan.

Click the Test Plan module button in the sidebar to open the Test Plan 
module.

If the Reservation_Test business process test is not currently displayed, select 
Reservation_Test in the test plan tree, and click the Test Script tab. 
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 7 Display the Components tab in the Test Script tab.

Click the Select Component button in the Test pane toolbar. The 
Components tab opens in the Components and Flows pane.

In the Component Tree, expand the BPT_Tutorial folder that contains your 
components.

 8 Add the Delete Order component to the test.

Select the Update Order component in the Test pane. Double-click or drag 
the Delete Order component in the Component Tree to add it to the test 
below the Update Order component and above the Logout component.

The Promote Parameters dialog box opens. This dialog opens because the 
test already has at least one parameter defined. 

Select the Promote all parameters to the test level radio button and click 
OK.

In the On Failure column in the Test pane, change the failure condition for 
the Delete Order component to Exit.

 9 Save the component.

Click the Save button in the toolbar to save your changes.

 10 Close the Components and Flows pane.

Click the Close button in the Components and Flows pane toolbar.

Now that you have parameterized steps in your test, you are ready to 
configure the values of these parameters and define the iterations for your 
test.
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Iterating Components

Iterations are the number of times that an individual business component, a 
flow of components, or a group of components runs within a single test run, 
or the number of times that an entire business process test runs within a test 
set. 

In this section, you configure the Create Order, Update Order, and Delete 
Order business components to each run three iterations.

The flow of business components and iterations is illustrated as follows:

After opening the Flight Reservations application and logging in, the 
business process test runs the Create Order component three times 
consecutively, each time creating an order with a different destination. The 
Update Order component then runs three times, and updates each of the 
created orders. Then the Delete Order iteration deletes each of the orders. 
The test then exits the Mercury Flight Reservations application.

Iterating Using Test Data
Earlier in this lesson, you parameterized the Fly To step of the Create Order 
component. Now you will configure your test so that the step will use data 
defined by the test for each iteration.

 1 Display the Test in the Test Plan module.

Ensure that the Reservation_Test business process test is selected in the test 
plan tree of the Test Plan module, and click the Test Script tab.
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 2 Configure various destination cities.

Click the Destination input parameter link in the Input column of the 
Create Order component.

The Component Iterations dialog box opens.

Select the Destination parameter column. Zurich is displayed in the 
Parameter Value cell.

Note: The value type defined for the component parameter, for example, 
String or Number, is displayed at the top of the column. You can only 
configure a value that matches the value type for the component parameter. 

Click the Add Iteration button in the toolbar twice. Two additional iteration 
rows are added to the Component Iterations dialog box. The parameter 
value Zurich from the previous row is automatically duplicated in the new 
rows.

In the Iteration #1 and Iteration #2 cells, overwrite the value Zurich with the 
values Paris and Seattle respectively.
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Tip: You can press the TAB or Up and Down arrow keys on your keyboard to 
move from one iteration row to another.

Click OK. The number of defined iterations for the Create Order component 
is displayed in the Input column of the Test Script tab.

Iterating Using Output Values from Previous Components
Earlier in this lesson, you parameterized the Order Number Edit step of the 
Update Order component. Now you will configure your test so that the step 
will use data generated from a previous component.

 1 Display the Test in the Test Plan module.

Ensure that the Reservation_Test business process test is selected in the test 
plan tree of the Test Plan module, and click the Test Script tab.

 2 Configure the Order Number input value.

Click the Order_Number_In input parameter link in the Input column of 
the Update Order component.

The Component Iterations dialog box opens. 
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 3 Use data from a previous component as the input for this parameter.

Select the Output of previous component check box. The Select Output 
Parameter dialog box opens. Only one output parameter has been defined in 
previous components in the test so it is automatically selected.

Click OK. An iterations mismatch confirmation message is displayed. This 
indicates that the number of iterations currently defined for your Update 
Order component (1 iteration) does not match the number of iterations 
currently defined for the Create Order component from which you are 
retrieving the data (3 iterations).

Click Yes to close the confirmation message.

The Component Iterations dialog box indicates that the parameter will use 
the value generated from the first iteration of the Order_No_Out parameter 
in the Create Order component. The input parameter is shown in red to 
indicate an iterations error. 
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Click OK in the dialog box to close it. The iterations error is shown in red in 
the Test Script tab.

 4 Add iterations to your Update Order component.

To make the number of iterations in the Update Order component match 
those of the Create Order component, you must add two more iterations. 

Click the Iterations link of the Update Order component to open the 
Component Iterations dialog box.

Click the Add Iteration button in the toolbar twice. Two additional iteration 
rows are added to the Component Iterations dialog box. 

The parameter values show that each iteration of the Update Order 
component will use the value of the Order_No_Out parameter from the 
corresponding Create Order component.

Click OK to close the dialog box. 

Note that the iterations error is no longer shown in the Test Script tab.
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 5 Add iterations to your Delete Order component.

Your Delete Order component uses the same input parameter as the Update 
Order component. Repeat steps 2 through 4 to add three iterations to the 
Delete Order component, each using the Order_No_Out parameter from the 
corresponding Create Order component.
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Debugging the Parameterized Test

You made several modifications to your test. Before moving forward, it is a 
good idea to run your test again to confirm that it runs successfully.

 1 Run the test.

In the Test pane of the Test Script tab, click the Run or Debug Test button in 
the toolbar. The Run or Debug Test dialog box opens.

You are confirming that the test as a whole still runs smoothly after your 
changes. Therefore, leave all components set to Normal mode.

Click OK to close the Run or Debug Test dialog box. QuickTest Professional 
opens on your computer and begins to run the test. However, at the end of 
the Create Order component, a QuickTest error message is displayed.
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The QuickTest error message indicates that it was unable to retrieve a 
number for the Order_No_Out parameter.

 2 Stop the component and test run.

Click Stop in the Run Error dialog box. QuickTest stops running the 
component and, because the test is set to exit if the component fails, the test 
run also ends.

When the run stops, the component remains open in QuickTest. Display 
Quality Center by clicking the Microsoft Internet Explorer icon in the task 
bar. The Debug Run Information dialog box indicates that the run failed.

Click Close in the Debug Run Information dialog box.

In the Flight Reservations dialog box, select File > Exit. 

 3 Analyze the problem.

The QuickTest error message indicated that it was unable to retrieve a 
number for the Order_No_Out parameter. The reason for this is that 
QuickTest tries to perform the GetValue step immediately after it clicks the 
Insert Order button in the previous step. 

Therefore, it attempts to retrieve the value before the Mercury Flight 
Reservations application has finished inserting the order and at that time, 
the Order No text box is empty.
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When the Mercury Flight Reservations application is inserting the order, the 
dialog box is not active. To ensure that the Insert Order operation is 
complete before the GetValue step is performed, you can add a step that 
activates the Flight Reservation dialog box. This will cause QuickTest to wait 
until it can identify the dialog box (it can identify only active dialog boxes) 
and will give the Mercury Flight Reservations application time to complete 
the order transaction.

 4 Modify the component to solve the problem.

Click the Business Components module button in the sidebar and select the 
Create Order component. Click the Automation tab if it is not already 
displayed.

Select the Order Information.Insert Order Button step and click the Add 
Step button in the toolbar. A new step is added, and the Select an item 
menu opens.

The Flight Reservation Dialog is not a sibling or child of the Order 
Information.Insert Order Button item, and is therefore not displayed in the 
Select an item list.

Select Select another object from the list. The Select Object for Step dialog 
box opens. Select Flight Reservation Dialog in the Object repository tree and 
click OK. The Select Object for Step dialog box closes. 

Accept the default Activate operation for the step.

 5 Save the component.

Click the Save button in the Automation tab toolbar to save the Update 
Order component.

 6 Set the test to run in debug mode.

Click the Test Plan module button in the sidebar. Ensure that the 
Reservation_Test business process test is selected in the test plan tree, and 
click the Test Script tab.

Click the Run or Debug Test button in the toolbar. The Run or Debug Test 
dialog box opens. 
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The test run failed between the Create Order and Update Order 
components. In the Run Mode column of the Create Order and Update 
Order components, select Debug.

 7 Begin the debug run.

Click OK in the Run or Debug Test dialog box to begin the debug run. 
QuickTest performs the Login component steps and opens the Create Order 
component. Then it pauses at the first step in the component. A breakpoint 
icon  appears to the left of the first step.

Ensure that QuickTest and the Mercury Flight Reservations application are 
positioned so that you can see both applications simultaneously.

In the QuickTest Test toolbar, click the Run button. QuickTest runs the steps 
in the component. 

Note that the arrow in the QuickTest margin now pauses for several seconds 
next to the Flight Reservation Dialog.Activate step while QuickTest waits for 
the dialog box to become available. This enables QuickTest to perform the 
Activate operation and proceed to the Order No.GetValue step only after the 
Insert Order operation is complete.
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Because you are running several iterations of the components, the Create 
Order component opens twice more, each time stopping at the breakpoint 
at the beginning of the component. Click Run twice more to complete the 
Create Order component iterations. 

During each iteration of the Create Order component, note the order 
numbers that the Flight Reservation dialog box displays in the Order No 
box. These are the numbers that your component is retrieving for the 
Order_No_Out output parameter.

The Update Order component opens and pauses at the breakpoint at the 
first step. It seems that the problem was solved by the new step in the Create 
Order component, but to confirm, click in the margin next to the OK 
button step to add a breakpoint. This will pause the component run 
immediately after the component inserts the order number retrieved from 
the previous component. 

Click the Run button in the QuickTest Test toolbar. When the component 
pauses, note that the number inserted in the Open Order number dialog box 
of the Flight Reservations application matches the number that you saw in 
the Order No text box at the end of the previous component.

Click Run again to proceed. When the component ends, it again pauses at 
the breakpoint at the first step of the Update Order component. For the 
second and third iterations of this component, you can click Run to let the 
component complete its run.

The Delete Order and Logout components are set to run in Normal mode. 
After the three Update Order component runs, the Delete Order 
component runs three times. Then, the Logout component immediately 
runs once and closes the Flight Reservation dialog box.
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 8 View the test results.

When the run is complete, the last component in the test (Logout) remains 
open in QuickTest. Display Quality Center by clicking the Microsoft 
Internet Explorer icon in the task bar.

Review the summary information of the test and the component iterations 
in the Debug Run Information dialog box.

Note the order of the iteration runs for the Create Order, Update Order and 
Delete Order components: 1-2-3, 1-2-3, 1-2-3.

Click Close to complete the test run.

 9 Save the Reservation_Test.

You will create new tests using the saved Reservation_Test in the following 
sections and lessons. 

Now that you have successfully debugged your test, you are ready to add 
finishing touches to your test by adding components to a flow, including 
the flow in a test, and selecting iterations to run.
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Working with Flows

A Flow comprises a collection of business components in a fixed sequence. 
You can use a flow in multiple business process tests. When you modify a 
flow or any of its components, all business process tests containing that flow 
reflect that modification. 

Note: (Optional) Quality Center also enables you to combine two or more 
components in a test and then iterate them as a group. For a descriptive 
procedure, see “Grouping Components” on page 120.

Much of the functionality available in Quality Center when working with 
flows is the same as the functionality when working with business process 
tests. However, working with flows provides some additional functionality, 
such as run conditions. 

A run condition checks the current value of a given parameter before 
running a component in a flow. Based on the parameter value and the run 
condition definition, it then determines whether to run the component, 
skip to the next component, or end the component run and set the 
component status to fail. For more information on working with run 
conditions, see the HP Business Process Testing User Guide.

A useful flow in the Flight Application would be the opening and updating 
of a selected order. Similarly, you could create a flow that would open an 
order and delete it from the database. This would provide you with building 
blocks that you could use in multiple tests, but that have single points of 
maintenance. 

In this section, you will create a flow that opens and updates a selected 
order. You then include the flow in a business process test. Separating the 
operations for opening an order from those of updating an order creates a 
reusable building block that can be used in other tests and flows.

This section comprises the following steps:

“Step 1: Create a new Business Process Test” on page 109, by copying the 
saved Reservation_Test and renaming it.



Lesson 7 • Working with Parameters

109

“Step 2: Create Two New Components” on page 109, namely the Open 
Order and Update Open Order components.

“Step 3: Create a New Flow” on page 111, by adding the new components to 
the flow.

“Step 4: Build your Business Process Test” on page 114, using the new 
components and the new flow. 

Step 1: Create a new Business Process Test
In this step, you create a new business process test. You can use the saved 
Reservation_Test to create the new test. 

 1 Copy Reservation_Test and paste it into the test plan tree. 

Click the Test Plan module button in the sidebar to open the Test Plan 
module. Right-click Reservation_Test in the test plan tree, and select Copy.

Right-click the BPT_Tutorial folder in the tree and select Paste. A duplicate 
test name warning is displayed. Click OK. A copy of Reservation_Test, 
named Reservation_Test_Copy_1, is pasted in the test plan tree.

 2 Rename the new test.

Right-click the new test and select Rename. Enter 
Reservation_Test_with_Flow as the name of the test and click on another 
location to save the new name. 

Step 2: Create Two New Components
In this step, you create two new components that open and update a 
selected order. The new components are both based on the existing Update 
Order business component.

 1 Copy Update Order and paste it twice into the component tree. 

Click the Business Components module button in the sidebar. The Business 
Components module opens.

Right-click the Update Order component in the component tree and select 
Copy. 
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Right-click the BPT_Tutorial folder in the tree and select Paste. A duplicate 
name warning is displayed. Click OK. A copy of Update Order, named 
Update Order_Copy_1, is pasted in the component tree.

Right-click the BPT_Tutorial folder and select Paste again. A duplicate name 
warning is displayed. Click OK. Another copy of Update Order, named 
Update Order_Copy_2, is pasted in the component tree.

 2 Rename the new components.

Right-click the first new component and select Rename. Enter Open Order as 
the name of the component and click on another location to save the new 
name. 

Right-click the second new component and select Rename. Enter Update 
Open Order as the name of the component and click on another location to 
save the new name. 

 3 Delete the steps not required by the Open Order component.

Open the Automation tab of the Open Order component. The last three 
steps are not required in this component. 

Select the last three steps and click the Delete Step button in the toolbar. A 
warning message is displayed. Click Yes.

Click the Save button in the Automation tab toolbar to save the Open Order 
component.

 4 Delete the steps not required by the Update Open Order component.

Open the Automation tab of the Update Open Order component. The last 
three steps are the only steps required in this component. 

Select all the steps before the Flight Reservation Dialog.Activate step and 
click the Delete Step button in the toolbar. A warning message is displayed. 
Click Yes.

Click the Save button in the Automation tab toolbar to save the Update 
Open Order component.
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Step 3: Create a New Flow
You build the structure of your flow by selecting the business components 
you created and adding them to the flow. You then configure their run 
settings, and define what the flow will do if one or more of the components 
fail.

In this step, you create a new flow in the test plan tree of the Test Plan 
module.

 1 Open the Test Plan module.

Click the Test Plan module button in the Quality Center sidebar. The Test 
Plan module opens. 

 2 Add a new flow to the BPT_Tutorial folder.

Ensure that BPT_Tutorial is selected in the test plan tree. Click the New Test 
button in the toolbar above the tree. The Create New Test dialog box opens.

From the Test Type list, select FLOW. (Quality Center treats a flow as a type 
of test.)

In the Test Name box, enter FLOW_Update_Order.

Click OK. 

Note: If the project administrator defined required fields in Project 
Customization in Quality Center, the Required Test Fields dialog box opens. 
Select any value for each of the displayed fields. 
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The new flow is added to the BPT_Tutorial folder in the test plan tree. In the 
same way as for tests, the flow tabs are displayed on the right of the 
Quality Center window.

 3 Add a flow description.

The Details tab contains both required and optional fields, as well as the 
Description and Comments tabs.

In the Description tab, enter a description for the flow. For example: This 
flow opens an existing order in the Flight Reservations application and updates 
some of its details.

 4 Display the available components in the Test Script Tab.

Select FLOW_Update_Order in the test plan tree. The flow tabs are 
displayed.

Click the Test Script tab. This tab comprises two panes: the Test pane on the 
left of the tab, and the Components tab on the right. The Components tab 
contains the available business components in a tree hierarchy. 

Ensure that the Components tab is displayed. If it is not displayed, click the 
Select Component button in the Test pane toolbar.
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In the tree in the Components tab, expand the BPT_Tutorial folder that 
contains the components you created.

Tip: To expand a folder in the component tree, click the Expand symbol  
to the left of the folder name or double-click the folder.

 5 Add components to the flow.

Drag the Open Order component from the component tree and drop it in 
the Test pane. The Promote Parameters dialog box opens. Select the Promote 
all parameters to the flow level radio button and click OK.

Drag the Update Open Order component from the component tree and 
drop it below the Open Order component. The Promote Parameters dialog 
box opens. Ensure that the Promote all parameters to the flow level radio 
button is selected and click OK.
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 6 Close the Components and Flows pane.

You have added both the required components to your flow. 

Click the Close button in the Components and Flows pane toolbar.

 7 Define Failure Conditions.

For each component, define the condition that instructs your flow to stop 
running if the component fails.

In the Test pane of the Test Script tab, click in the On Failure column for 
each component. A down arrow is displayed. (You may have to scroll to the 
right or resize your columns to view this column.) Click the down arrow and 
select Exit from the list. This defines that your flow will end if the 
component fails.

Note: By default, Continue is defined for each business component when it 
is added to a flow. This means that the flow will run the next component 
even if the specific component fails.

 8 Save the flow.

Click the Save button in the tab toolbar to save your new flow.

Step 4: Build your Business Process Test
You build the structure of your business process test by selecting available 
flows and business components and adding them to the test. 

 1 Display the available flows and components in the Test Script Tab.

The flows and components you created are available for use in the Test Plan 
module.

All flows in the Test Plan module, and all business components in the 
Business Components module, created by you or by others, are available for 
use. This means that flows and components can be used in multiple tests. 
For example, the Login component you created could be used in any test or 
flow that opens the Mercury Flight Reservations application.
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Select Reservation_Test_with_Flow in the test plan tree. The test tabs are 
displayed.

Click the Test Script tab. 

Ensure that the Components and Flows pane is displayed. If it is not 
displayed, click the Select Component button in the Test pane toolbar to 
open the pane with the Components tab displayed. You can also click the 
down arrow next to the Select Component button and select Select Flow to 
open the Flow tab. 

The Components and Flows tab comprises two panes: the Test pane on the 
left of the tab, and the Components and Flows pane on the right. 

➤ The Test pane currently shows the same components that were included in 
Reservation_Test. 

➤ The Components and Flows pane contains the available components and 
flows in separate tree hierarchies. 

In this section, you will replace the Update Order component with the flow 
that contains the new Open Order and Update Open Order components.

In the tree in the Components tab, expand the BPT_Tutorial folder that 
contains the components you created.

Test Pane

Components Tab 
and Flows Tab
in the 
Components and 
Flows Pane
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Tip: To expand a folder in the component tree, click the Expand symbol  
to the left of the folder name or double-click the folder.

 2 Delete the component not required by this test.

The Update Order component is not required in the 
Reservation_Test_with_Flow test. 

Select the Update Order component and click the Remove Selected 
Components from Test button in the toolbar. A warning message is 
displayed. Click Yes.

 3 Add the new flow to the test.

Open the Flows tab.

In the tree in the Flows tab, expand the BPT_Tutorial folder that contains 
the flow you created.

Drag the FLOW_Update_Order flow from the tree and drop it in the Test 
pane below the Logout component. The Promote Parameters dialog box 
opens. Ensure that the Promote all parameters to the test level radio button 
is selected and click OK.
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 4 Close the Components and Flows pane.

Click the Close button in the Components and Flows pane toolbar.

 5 Arrange the selected flow and components into a logical testing sequence.

Use the Move Up and Move Down buttons in the toolbar to arrange the flow 
and components in the test. The Test pane should look as follows:

 6 Set the flow to iterate for each of the created components.

In the Test pane, right-click the flow and select Iterations. The Flow 
Iterations dialog box opens. 

Click the Add Iteration button in the toolbar twice. Two additional iteration 
rows are added to the Flow Iterations dialog box. The parameter value from 
the previous row is automatically duplicated in the new rows.

 7 Use data from a previous component as the input for this parameter.

Select the Output of previous component check box. The Select Output 
Parameter dialog box opens. Only one output parameter has been defined in 
previous components in the test so it is automatically selected.

Click OK in the Select Output Parameter dialog box and in the Flow 
Iterations dialog box. 
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The Test pane should look as follows:

 8 Save the Business Process Test.

Click the Save button in the tab toolbar to save your new business process 
test.

 9 Run the test to confirm that the components run successfully.

Click the Run or Debug Test button in the toolbar.

The Run or Debug Test dialog box opens. Click the Normal button under Set 
all test to: so that all components, including those in the flow, will run in 
Normal mode. Click OK to close the Run or Debug Test dialog box and run 
the business process test.



Lesson 7 • Working with Parameters

119

 10 View the test results.

When the run is complete, the last component in the test (Logout) remains 
open in QuickTest. Display Quality Center by clicking the Microsoft 
Internet Explorer icon in the task bar.

Review the summary information of the test and the component iterations 
in the Debug Run Information dialog box.

Click Close to complete the test run.

Now that you created and debugged your business process test, you can 
proceed to Lesson 8, “Running Business Process Tests.” In this lesson, you 
will learn how to select iterations to run and how to create run-time input 
parameter values, set test iterations, run business process tests in test sets, 
and view test results in the Test Lab module of Quality Center.

Alternatively, you can first proceed to the next section to learn about 
combining components into a group within a business process test. Groups 
provide another level of granularity in Business Process Testing and can also 
be iterated within a test. However, they are not reusable in other business 
process tests and are not shown in the test tree in the Test Plan module. 
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Grouping Components

Quality Center also enables you to combine two or more business 
components in a test and then iterate them as a group.

In this section, you group the Create Order and Update Order components 
in a new test based on the saved Reservation_Test. After opening the Flight 
Reservations application and logging in, the Create Order component 
creates an order to the first destination city, and the Update Order 
component updates the class. New orders are then created and updated for 
the second and third destinations. The business process test then deletes 
these orders (to return the flight reservation database to its previous status) 
and closes the application.

The process is illustrated as follows:

You can use the saved Reservation_Test to create a new business process test. 
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 1 Copy Reservation_Test and paste it into the test plan tree. 

Click the Test Plan module button in the sidebar to open the Test Plan 
module. Right-click Reservation_Test in the test plan tree, and select Copy.

Right-click the BPT_Tutorial folder in the tree and select Paste. A duplicate 
test name warning is displayed. Click OK. A copy of Reservation_Test, 
named Reservation_Test_Copy_1, is pasted in the test plan tree.

 2 Rename the new test.

Right-click the new test and select Rename. Enter 
Reservation_Test_with_Group as the name of the test and click on another 
location to save the new name. 

 3 Display the components in the test.

Ensure that the Reservation_Test_with_Group business process test is 
selected in the test plan tree, and the Test Script tab is displayed. 

 4 Group selected components.

In the Test Script tab, select both the Create Order and Update Order 
components. 

You can select multiple components using standard Windows selection 
techniques (using the left mouse button and SHIFT key). 

Click to the left of the Create Order component row. Ensure that the entire 
row is selected (the whole row should be highlighted). Hold down the SHIFT 
key and select the Update Order component. Both component rows are 
highlighted.
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Right-click and select Component Grouping > Group Components/Flows 
from the context menu. The group is created as indicated by the border 
around the selected components.

 5 View the iteration settings.

Click the group iterations link in the group border to open the Group 
Iterations dialog box and view the iteration settings. Note that both the 
Destination and Order_Number_In parameters are displayed in the same 
dialog box and they retain the configuration settings you assigned in the 
previous sections of this lesson. Click OK to close the dialog box.

 6 Save the changes.

Click the Save button on the tab toolbar.

 7 Run the components to confirm that the test runs successfully.

Click the Run or Debug Test button in the toolbar.

The Run or Debug Test dialog box opens. Click the Normal button under Set 
all test to: so that all components will run in Normal mode. Click OK to 
close the Run or Debug Test dialog box and run the business process test.
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 8 View the test results.

When the run is complete, the last component in the test (Logout) remains 
open in QuickTest. Display Quality Center by clicking the Microsoft 
Internet Explorer icon in the task bar.

Review the summary information of the test and the component iterations 
in the Debug Run Information dialog box.

Note that the order of the iteration runs for the Create Order, Update Order 
and Delete Order components differs from the previous run without the 
grouping: 1-1, 2-2, 3-3, 1-2-3.

Click Close to complete the test run.

You can now proceed to Lesson 8, “Running Business Process Tests.” In this 
lesson, you will learn how to select iterations to run and how to create 
run-time input parameter values, set test iterations, run business process 
tests in test sets, and view test results in the Test Lab module of 
Quality Center.
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8
Running Business Process Tests

This lesson teaches you how to select component iterations to run, how to 
create run-time input parameter values, and how to set test iterations. 

You use run-time parameters to provide values for business components 
when your business process test runs. This enables you to iterate entire tests 
using variable input values that can provide differing test results.

This lesson also describes how to view detailed reports showing the results 
of the business process test when the run is complete. In contrast with the 
simple pass or fail-type results provided with debug runs, these results 
include details on the configuration of each business component, the actual 
value of each component parameter used in the test, and the results of 
individual steps. This enables you to identify failed steps, or determine 
whether the results of your test were as expected.

In this lesson, you will learn about:

 ➤  Selecting Iterations to Run on page 126

 ➤  Creating a Run-Time Parameter on page 129

 ➤  Setting Up a Business Process Test in the Test Lab Module on page 133

 ➤  Running the Business Process Test in the Test Lab Module on page 136

 ➤  Viewing Run Results on page 139

This lesson focuses specifically on setting up and running business process 
tests in test sets in the Test Lab module. For general information about 
working with the Test Lab module, see the HP Quality Center User Guide.
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Selecting Iterations to Run

After you configure parameter values for a component, a flow of 
components, or a group of components, you can select to run only one 
iteration or a specific range of iterations. In this section, you define that 
only two of the three destination parameters you defined are input during 
the run (and as a result, only two order numbers are retrieved in the 
subsequent components).

 1 Open the Test Plan module, if it is not already open.

Click the Test Plan module button in the Quality Center sidebar. The Test 
Plan module opens. 

 2 Select iterations to run.

Select Reservation_Test_with_Flow in the test plan tree. The test tabs are 
displayed.

In the Test Script tab, click the Iterations link for the FLOW_Update_Order 
flow in the Input column. The Flow Iterations dialog box opens. Click the 
Select Iterations button in the toolbar. The Select Iterations dialog box 
opens.

Select the Run from radio button. The from and to spin boxes are enabled.

Click the up arrow in the to box to change the iteration number to 2. This 
specifies that only iterations 1 and 2 will run in the business process test.

Click OK. 
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The iteration that is not included in the range (Iteration #3) is grayed in the 
iteration list.

Click OK in the Flow Iterations dialog box. The selected range is displayed in 
the Test Script tab together with the Iterations link for the flow.
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 3 Fix the iterations error.

When you selected the iterations to run for the flow, you instructed the test 
to update only two orders. However, the test is currently set to create and 
later delete three orders. You must change the Create Order and Delete 
Order iteration settings to match the flow iteration settings.

➤ Click the Delete Order iterations link. The Component Iterations dialog box 
opens. 

Click the Select Iterations button in the toolbar. The Select Iterations dialog 
box opens.

Change the iteration settings. The total number of iterations must match for 
components whose parameters refer to previous components, but the 
specific iteration numbers you choose can be different. Select the Run from 
radio button. Click the up arrow in the from box to change the iteration 
number to 2. Click the up arrow in the to box to change the iteration 
number to 3. This specifies that only iterations 2 and 3 will run in the 
business process test.

Click OK to close the Select Iterations dialog box. Click OK to close the 
Component Iterations dialog box.

➤ Change the Create Order iteration settings in the same way as you changed 
the Delete Order settings. The selected ranges are displayed in the Test Script 
tab together with the Iterations links.

 4 Save the changes.

Click the Save button on the Test Script tab toolbar.

 5 Run the components.

Click the Run or Debug Test button in the toolbar.

The Run or Debug Test dialog box opens. 

Click OK to close the Run or Debug Test dialog box and run the business 
process test.

 6 View the results.

When the run is complete, display Quality Center.
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Review the summary information of the test and the component iterations 
in the Debug Run Information dialog box.

Click Close to complete the test run.

Creating a Run-Time Parameter

In this section, you define a run-time parameter for the Agent Name step in 
the Login component. Later, you will provide two input values for this 
run-time parameter to run two consecutive iterations of your business 
process test, each with a different agent name.

 1 Create a new parameter for the Login component.

Click the Business Components module button in the sidebar. The Business 
Components module opens.

Select the Login component in the component tree, and click the 
Parameters tab.
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In the Input pane toolbar, click the New Input Parameter button. The New 
Parameter dialog box opens:

Enter AgentName in the Parameter Name box and click OK. 

A line for the new input component parameter is added in the Input 
parameter list in the Parameters tab. String is entered automatically in the 
Value Type cell. 

Leave the Default Value cell blank. In the Description cell, enter a 
description of the component parameter’s purpose, or other descriptive text. 
For example: Login user names. Can be any 4 or more characters.

 2 Change the Agent name step from a fixed value to a component parameter.

Click the Automation tab.

In the Agent Name step, click in the Value cell. The Configure the value 
button is displayed. Click the button. The Value Configuration Options 
dialog box opens.

Click the Parameter radio button and ensure that Component parameter is 
selected. Click the down arrow next to the parameter name to display the 
description of the parameter you created in the previous step.

Click OK. The Value Configuration Options dialog box closes.

 3 Save the changes to your component.

Click the Save button in the Automation tab toolbar.
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 4 Define the parameter as a run-time parameter.

Click the Test Plan module button in the sidebar to open the Test Plan 
module.

Click the Test Script tab for the Reservation_Test_with_Flow business 
process test. The new input parameter you created, and a link, are displayed 
in the Input column of the Login component. (If the link is not visible, click 
the Refresh button.) 

The input parameter link is blank because no value is defined for it yet. 
Click the input parameter link in the Input column. The Component 
Iterations dialog box opens. 

Click in the cell to the right of the Parameter Value cell and then click . 
The Set String Value dialog box opens. 

Select the Run-time parameter radio button. Then click the Add Run-Time 
Parameter button. The New Run-Time Parameter dialog box opens. 

Enter a descriptive name for the run-time parameter, for example, 
AgentName, and click OK. The run-time parameter name you entered is 
displayed in the Set String Value dialog box between { } brackets. Click OK.
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The run-time parameter name you entered is displayed in the Component 
Iterations dialog box between { } brackets.

Make sure that the { } brackets are not deleted, as they instruct 
Quality Center to treat the component parameter as a run-time parameter 
and not as a fixed value.

 5 Close the Component Iterations dialog box.

Click OK. The new run-time parameter name for the Login component is 
displayed in the Test Script tab between { } brackets.
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Setting Up a Business Process Test in the Test Lab Module

In the Test Lab module, you create test sets and choose which business 
process tests to include in each set. In this lesson, you create the test set that 
contains the single business process test you created in Test Plan. You then 
define iterations for the test.

Setting up a business process test requires the following steps:

➤ Creating a Test Set in a Folder

➤ Adding a Test to your Test Set

➤ Defining Iterations for the Business Process Test

Creating a Test Set in a Folder
In this section, you create a new folder containing a test set.

 1 Open Test Lab and display the test sets tree.

Click the Test Lab module button in the sidebar to open the Test Lab 
module.

If the Test Lab tree view is not already displayed, select View > Test Sets Tree.

 2 Define a new test folder.

In the test sets tree, select the Root folder.

Click the New Folder button in the toolbar. The New Folder dialog box 
opens.

Enter BPT_Tutorial and click OK. The new folder appears under Root in the 
test sets tree.
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 3 Add a test set to your folder. 

Ensure that the new folder is selected in the test sets tree, and click the New 
Test Set button in the toolbar. The New Test Set dialog box opens. 

In the Test Set Name box, enter Reservation_Test_Set. 

In the Description box, enter a description of the test set, for example, This 
test set contains only the Reservation_Test business process test.

Click OK.

Reservation_Test_Set is added to the BPT_Tutorial test set folder in the test 
sets tree. 
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Adding a Test to your Test Set
After you define a test set, you can add your business process test to it. 

 1 Display the test plan tree.

Select Reservation_Test_Set in the test sets tree.

If the Test Plan tab is not currently displayed on the right side of the screen, 
click the Select Tests button in the Execution Grid tab toolbar. The Test Plan 
Tree tab in the right pane displays the tree from the Test Plan module.

 2 Add your test to the test set.

In the test plan tree, expand the BPT_Tutorial folder and select 
Reservation_Test_with_Flow.

Double-click or drag to add the test to the Execution Grid.

Click the Close button to close the Test Plan Tree pane. 

Defining Iterations for the Business Process Test
In this section, you configure the business process test to run iterations 
according to the run-time parameter values that you define.

 1 Select the Reservation_Test test set in the test sets tree. The business process 
test that comprises the test set is displayed in the Execution Grid tab.
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 2 Right-click Reservation_Test_with_Flow in the tab and select Iterations. The 
Test Iterations dialog box opens.

In the Test Iterations dialog box, click the Add Iteration button. An 
additional iteration row is added.

In the AgentName Iteration cells, enter a name for each agent, for example 
AgentOne, and AgentTwo. This instructs the business process test to log into 
the Flight Reservations application twice, using a different login name in 
each iteration of the test.

Click OK to close the Test Iterations dialog box.

Running the Business Process Test in the Test Lab Module

You can now run the business process test.

 1 Reset the Exit conditions for all components.

In Lesson 7, “Working with Parameters,” you temporarily set all 
components to exit on failure while you debugged your test. Now that your 
test runs smoothly, you are ready to run your test to test new builds of your 
application. You can reset the exit conditions so that they exit the test run 
only if it does not make sense to continue the run after such a failure.
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Click the Test Plan module button in the sidebar to open the Test Plan 
module, and click the Test Script tab, if it is not currently displayed. Select 
Continue for the Update Order flow and for the Delete Order and Logout 
components. Since the Update Order flow, Delete Order, and Logout 
components are dependent on the success of the Login and Create Order 
components, keep the Exit condition for these components.

 2 Save the changes.

Click the Save button on the tab toolbar.

 3 Define the test execution details.

Click the Test Lab module button in the sidebar to open the Test Lab 
module.

Select the business process test in the Execution Grid and click the Run 
button in the tab toolbar. 

The Automatic Runner dialog box opens.

Ensure that the Run All Tests Locally check box is selected. This runs the 
business process test using QuickTest Professional on your local computer. 
(If you want to run the test on a different host computer, clear the Run All 
Tests Locally check box and, in the Run on Host cell, enter a valid host name 
that has QuickTest Professional 10.00 installed.) 
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Ensure that the Enable Log check box is selected. This enables QuickTest to 
record an execution log of the test run.

 4 Run the test.

Select the Reservation_Test_with_Flow business process test in the dialog 
box and click the Run button in the toolbar. 

QuickTest Professional opens and runs the business process test in the test 
set. 

From your task bar, you can toggle between the Test Lab module, QuickTest, 
and the Flight Reservations application.

➤ The status of the test run, for example, Connecting, or Running, is shown 
in the Status column of the Automatic Runner dialog box.

➤ The status of the test run is shown in QuickTest Professional in the status 
bar at the bottom of the QuickTest window.

After the Logout component closes the Mercury Flight Reservations 
application and the test run ends, display the Test Lab module in 
Quality Center. 

The overall result of the run is shown in the Status column of the Automatic 
Runner dialog box.

After you run a business process test from the Test Lab module, you can view 
detailed results, as described in the next section.
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Viewing Run Results

You can view the results of your business process test in various formats. 
This section describes the following:

➤ Viewing the Execution Log

➤ Viewing Last Run Results in the Test Lab Module

➤ Viewing the QuickTest Report

Viewing the Execution Log
The Execution Log provides a log of the business process test (or tests) run in 
a test set. The log includes the date and time that each test was run, the host 
on which it was run, and the results of the tests.

 1 Open the Execution Log.

After the test run is complete, the Automatic Runner dialog box displays the 
Pass or Fail status of the test run.

Double-click in the dialog box.
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The Execution Log window opens and displays the results of the test run.

The box in the middle of the window lists the different operations in the 
business process test, such as the connection to the host, or the results of 
each test iteration. 

Select each line in turn. The results are displayed in the box at the bottom of 
the Execution Log window.

 2 Close the Automatic Runner dialog box.

In the Execution Log dialog box, select Log > Exit or click the Close button 
to return to the Automatic Runner dialog box.

In the Automatic Runner dialog box, select Run > Exit or click the Close 
button to return to the Test Lab window.
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Viewing Last Run Results in the Test Lab Module
You view the results of the latest business process test run in the Test Lab 
module in the Last Run Result pane at the bottom of the Execution Grid. 
The pane displays a hierarchical tree of each business component and step 
contained in the business process test, and the result obtained when the 
step ran, that is, Passed, or Failed. The run date and time are also shown. 

If one or more steps within a component receive a Failed result, the 
component itself displays a Failed status.

 1 Display the results of the last test run.

Ensure that the Last Run Result pane is displayed at the bottom of the 
Execution Grid tab. If the Last Run Result pane is not visible, click the Show 
button at the bottom-right of the Execution Grid tab. 

When the Last Run Result pane is first accessed, the tree displays only the 
iterations in the business process test.

 2 View the run results. 

Click the Expand symbol to the left of each iteration to view the result of 
each component.  

Then expand each component to view the main events in that component.

Select each of the items in the pane in turn to view a description of relevant 
information in the Description area.
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Viewing the QuickTest Report
You can view a full QuickTest report of a business process test run from the 
Test Lab module. This hierarchical report contains details on all the steps for 
all the different iterations and business components within the test run. 

 1 Open the Test Results window.

Open the Last Run Result pane at the bottom of the Execution Grid tab, as 
described in “Viewing Last Run Results in the Test Lab Module” on 
page 141. 

Click the Passed link in the Status column next to Test Iteration 1. 

The QuickTest Test Results window opens.

The Test Results window displays a graphical representation of the result of 
each step in the business process test. 
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 2 View detailed results for selected steps.

In the Test Results window, select View > Expand All and then select nodes 
in the tree to view the details of how the steps performed in the test. 

 3 View the results for Test Iteration 2.

Close the QuickTest Test Results window for Test Iteration 1. In the Last Run 
Result pane, click the Passed link in the Status column next to Test 
Iteration 2. The QuickTest Test Results window for Test Iteration 2 opens.

Expand the nodes in the tree to view the details of how the steps performed 
in the test. 

For more information about viewing and analyzing test results, select Help 
in the Test Results window, or see the HP QuickTest Professional User Guide.
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9
Where Do You Go from Here?

Now that you completed the lessons in this tutorial, you are ready to apply 
the Business Process Testing concepts and skills you have learned to your 
applications.

In this lesson, you will learn about:

 ➤  Getting Started on page 145

 ➤  Documentation Library on page 146

 ➤  Additional Online Resources on page 149

Getting Started

In this tutorial, you learned the basic workflow for creating automated 
keyword-driven components and business process tests in Quality Center as 
a Subject Matter Expert. 

Setting up Application Areas
This tutorial provided you with a ready-to-use application area containing 
an object repository and other required resources. 

Good application areas are one of the main keys to successful 
keyword-driven business process testing. To test your own applications, you 
should work closely with an Automation Engineer to set up one or more 
application areas that fit the needs of your applications and testing 
requirements. You can coordinate with the Automation Engineer to ensure 
that the object names in the object repository and the function names in 
the library files are names that will be easy for you to identify when you 
select items and operations from the Quality Center keyword view.
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Learning About Other Features
This tutorial touched on many of the mainstream Business Process Testing 
features, but before you go forward with creating tests on your own 
applications, you may want to familiarize yourself with additional features, 
including:

➤ Running business process tests manually

➤ Adding snapshots to components

➤ Viewing component Used-by lists

➤ Understanding component and test statuses

➤ Validating business process tests

➤ Using the Document Generator to generate information about your 
components and business process tests

➤ Working with WinRunner components

➤ And more....

HP provides many resources to help you learn about these and other 
Quality Center and Business Process Testing features, as described in the 
next sections.

Documentation Library

The Documentation Library is an online help system that describes how to 
use Quality Center. You can access the Documentation Library in the 
following ways:

➤ Click Documentation Library in the Quality Center Help menu to open the 
Documentation Library home page. The home page provides quick links to 
the main help topics.

➤ Click Help on this page in the Quality Center Help menu to open the 
Documentation Library to the topic that describes the current page.
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Documentation Library Guides

The Documentation Library consists of the following guides and references, 
available online, in PDF format, or both. PDFs can be read and printed using 
Adobe Reader, which can be downloaded from the Adobe Web site (http://
www.adobe.com).

Getting Started explains how to use the Documentation Library and how it 
is organized. (Available online.)

What’s New? describes the newest features in the latest version of 
Quality Center. (Available online and in PDF format.)

You can also access What’s New? from the Quality Center Help menu. In 
addition, you can select Help > Product Feature Movies to view short movies 
that demonstrate the main product features. 

Readme provides last-minute news and information about Quality Center. 

Quality Center Guides

HP Quality Center User Guide explains how to use Quality Center to 
organize and execute all phases of the application life cycle management 
process. It describes how to specify releases, define requirements, plan tests, 
run tests, and track defects. (Available online and in PDF format.)

HP Quality Center Administrator Guide explains how to create and maintain 
projects using Site Administration, and how to customize projects using 
Project Customization. (Available online and in PDF format.)

HP Quality Center Tutorial is a self-paced guide teaching you how to use 
Quality Center to manage the application life cycle management process. 
(Available in PDF format.)

HP Quality Center Installation Guide explains how to install Quality Center 
on a server machine in a cluster environment or as a standalone application. 
(Available in PDF format.)

HP Quality Center Upgrade Preparation Guide explains how to detect and 
repair problems before beginning a project upgrade. (Available in PDF 
format.)

HP Quality Center Database Best Practices Guide provides best practices for 
deploying Quality Center on database servers. (Available in PDF format.)

http://www.adobe.com
http://www.adobe.com
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Business Process Testing Guides

HP Business Process Testing User Guide explains how to use Business 
Process Testing to create business process tests. (Available online and in PDF 
format.)

HP Business Process Testing Tutorial provides a self-paced guide that teaches 
you the basics of Business Process Testing in the Quality Center application. 
(Available in PDF format.)

API References

HP Quality Center Database Reference provides a complete online reference 
for the project database tables and fields. (Available online.)

HP Quality Center Open Test Architecture API Reference provides a 
complete online reference for the Quality Center COM-based API. You can 
use the Quality Center open test architecture to integrate your own 
configuration management, defect tracking, and home-grown testing tools 
with a Quality Center project. (Available online.)

HP Quality Center Site Administration API Reference provides a complete 
online reference for the Site Administration COM-based API. You can use 
the Site Administration API to enable your application to organize, manage, 
and maintain Quality Center users, projects, domains, connections, and site 
configuration parameters. (Available online.)

HP Quality Center Entity Dependencies API Reference provides an online 
reference for managing relations between Quality Center entities. The 
reference covers a subset of the Quality Center COM-based API and a subset 
of the data tables used when managing relations. You can use this reference 
to integrate testing tools with Quality Center. (Available online.)

HP Quality Center Custom Test Type Guide provides a complete online 
guide for creating your own testing tool and integrating it into the Quality 
Center environment. (Available online.)
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Additional Online Resources

The following additional online resources are available from the 
Quality Center Help menu:

Troubleshooting & Knowledge Base accesses the Troubleshooting page on 
the HP Software Support Web site where you can search the Self-solve 
knowledge base. Choose Help > Troubleshooting & Knowledge Base. The 
URL for this Web site is http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software Support accesses the HP Software Support Web site. This site 
enables you to browse the Self-solve knowledge base. You can also post to 
and search user discussion forums, submit support requests, download 
patches and updated documentation, and more. Choose Help > HP Software 
Support. The URL for this Web site is www.hp.com/go/hpsoftwaresupport.

Most of the support areas require that you register as an HP Passport user 
and sign in. Many also require a support contract.

To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport user ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 

HP Software Web site accesses the HP Software Web site. This site provides 
you with the most up-to-date information on HP Software products. This 
includes new software releases, seminars and trade shows, customer support, 
and more. Choose Help > HP Software Web site. The URL for this Web site 
is www.hp.com/go/software.

Add-ins Page opens the HP Quality Center Add-ins Page, which offers 
integration and synchronization solutions with HP and third-party tools. 
For more information, refer to the HP Quality Center Installation Guide.

http://h20230.www2.hp.com/troubleshooting.jsp
http://www.hp.com/go/hpsoftwaresupport
http://h20230.www2.hp.com/new_access_levels.jsp
http://h20229.www2.hp.com/passport-registration.html
http://www.hp.com/go/software
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